
Welcome to AOL® Help - Offline
This "offline" help system answers your questions about connecting to the AOL service and using 
certain AOL features that are available when you aren't signed on. Use Help system to learn how to...

· write e-mail when you are not signed on 

· organize your e-mail

· change your settings

· set up the Web browser

· troubleshoot your system

· get around the AOL service

· manage your AOL account

· And so much more...

When you are signed onto to the AOL service, use the following areas for help:

AOL Keyword Description
Help The source for how-to information and step-by-

step instructions on using AOL’s most popular 
features.

Billing Change your name or billing address, change 
your payment method or price plan, plus view 
your AOL bill.

Access Find additional access numbers to connect to the
AOL service, plus get tips on staying connected.

For more information, see:
Getting the Most Out of Help 
Getting Around AOL Help 
Finding a Help Topic 
Viewing a Help Topic 
Copying a Topic 
Printing a Topic 
Hiding and Showing the Help Contents 
Changing the Size of the Help Window 



AOL System Requirements
You will need the following minimum hardware and software to run AOL® 9.0 Security Edition SE:

· Pentium® class processor 166 MHz or higher 
· Windows® operating system of Windows 98 or higher 
· Internet Explorer 6.0 or higher 
· Between 399 - 402 MB of free hard drive space to install AOL 9.0 Security Edition SE 

depending on your Windows operating system, and up to an additional 85 MB if you need to 
install a new version of Internet Explorer 

· 128 MB (megabytes) of RAM minimum 
Ø For PCs with less than 110 MB (megabytes) of RAM, AOL 9.0 Security Edition LE will

be installed
· VGA, SVGA or better display 
· 800x600 screen resolution (minimum), 1024x768 for optimal viewing 
· 28.8 Kbps or faster modem or other means of Internet connection

Pentium is a registered trademark of Intel Corporation.
Windows is a registered trademark of Microsoft Corporation.



Getting the Most Out of Help
Help is your first stop for finding answers to your questions about the AOL service or for fixing 
common problems you may have. You can scroll through the Help menu to see topic headings, or you 
can search for topics by clicking the Index or Search tab in the Help window.
Within a Help topic, you can click underlined words to see other information related to the topic.
Green underlined terms include definitions or additional information about a particular word or phrase.
Blue underlined terms indicate a link to a useful, related topic. For example, you can get around AOL 
Help using a variety of methods.
Blue underlined items indicate a link to further instructions. For example, if you see the words: Move 
This Help Window If It Is In The Way: you can click the link to get instructions on how to move the 
window. Click the pop up to make it disappear.

For more information, see:
Getting Around AOL Help 



Getting Around AOL Help
To navigate through Help topics you've seen: 

1 On the Help toolbar, click Back to display the last Help topic you saw.

2 On the Help toolbar, click the browse arrows to display the next  or previous 
 Help topic in the Table of Contents. 

For more information, see:
Finding a Help Topic 
Getting the Most Out of Help 



Finding a Help Topic
In the Help viewer window, click one of the following tabs:

· Click the Contents tab to browse through topics by category.
· To see a list of index entries, click the Index tab, and then either type a word or scroll 

through the list.
· To search for words or phrases that may be contained in a Help topic, click the Search tab.

In the left frame of the Help window, click the topic, index entry, or phrase to display the 
corresponding topic in the right frame.

For more information, see:
Getting the Most Out of Help 
Copying a Topic 
Printing a Topic 



Viewing a Help Topic
You can easily change the size of the type to make the help page easier to read.

1 In the right frame of the Help window, right-click inside the topic you want to copy, select Font.
2 Click Small or Large to reduce or enlarge the font appearance on your screen.

Note
Normal is the default font size, indicated by the checkmark (Ö).

For more information, see:
Copying a Topic 



Copying a Topic
1 In the right frame of the Help window, right-click inside the topic you want to copy, and click 

Copy.
2 Open the document where you want to copy the topic.
3 Click the place in your document where you want the information to appear.
4 On the Edit menu, click Paste.

Note
If you want to copy only part of a topic, select the text you want to copy, right-click your 
selection, and then click Copy.

For more information, see:
Printing a Topic 



Printing a Topic
1 In the left frame of the Help window, click the title of the topic you want to print.
2 From the Help toolbar, click Print.

Note
To print a pop-up topic, right-click inside the pop-up window, and click Print Topic.

For more information, see:
Copying a Topic 



Hiding and Showing the Help Contents
1 On the Help toolbar, click Help Topics to hide the table of contents, index, or search results list.
2 Click Help Topics again to display the table of contents, index, or search results list.

For more information, see:
Changing the Size of the Help Window  



Changing the Size of the Help Window
To make the left or right frame wider or narrower, point to the divider between the two panes, and 
when the pointer changes to a double-headed arrow, hold down the left mouse button as you drag the 
divider right or left.
To proportionally shrink or enlarge the whole Help window, point to any corner of the Help window. 
When the pointer changes to a double-headed arrow, hold down the left mouse button as you drag the 
corner of the window.
To change the whole Help window's height or width, point to the top, bottom, left, or right edge of the 
Help window, and when the pointer changes to a double-headed arrow, hold down the left mouse 
button as you drag that edge.

For more information, see:
Hiding and Showing the Help Contents 



Getting Help Online
To get help online

1 Sign on to the AOL service.
2 On the Help menu, click AOL Help.

Note
If you have an hourly billing plan, the time spent in the Help area is calculated and subtracted 
from your connect time when you sign off. (Telephone surcharges, if applicable, will still apply.)



Definition of a Frame
The Help window is divided into two vertical frames. Depending on whether the Contents tab, Index 
tab, or Search tab is active, the left frame displays the table of contents, index, or search results list. 
The right frame displays the Help topic corresponding to the entry selected in the left frame.



Solving Common AOL Problems
AOL software comes bundled with technology that can automatically repair some common error 
conditions. Let AOL help you automatically fix common problems with AOL Auto Fixes. Depending 
on your computer, it may take a few moments for the fix to begin.
Each of the following Auto Fix links may help resolve some connection issues. If you are having 
trouble getting connected to the AOL service or staying connected, try these Auto Fixes in the order 
below. After you try each Auto Fix, try using the AOL service for a while to see if the problem is fixed.
If you are still having problems, try the next Auto Fix.

Auto Fix 1:    Restart your computer. 
Auto Fix 2: Uninstalls and reinstalls the AOL Adapter. 
Auto Fix 3: Automatically redetects your connection device. 
Auto Fix 4: Deletes your current AOL connection.    Lets you set up a new location with new access 

numbers, if needed.
Auto Fix 5: Deletes and rebuilds the connectivity folder within the AOL software.

If you are having problems with the AOL software unexpectedly quitting, or are having trouble with 
the web browser, try one of the following Auto Fixes to resolve the issues.
I get Illegal Operation messages (GPF) when I use the AOL software 
The AOL Web browser 

For more information, see:
Calling AOL Technical Support 



Using System Information
System Information is an AOL utility program that provides information about your computer, your 
AOL connection, and other technical information about your computer that may be needed to fix any 
problems you may experience.
AOL System Information contains tools and utilities that may cause problems with your system if used 
incorrectly. 
CAUTION:    AOL System Information is to be used only under the direction of Member Services to 
reduce the risk of improper use of the tools provided by the program.



AOL® Companion Graphics Engine not registered
 Your AOL software is not functioning correctly.
 To fix the problem, reinstall your AOL software.

To reinstall your AOL software
1 Insert an AOL CD-ROM into your CD-ROM drive.
2 On the Windows Start menu, click Run. 
3 Type d:\setup (or e:\setup), then press ENTER.



AOL encountered a problem
Your AOL software has encountered a problem that prevents it from working correctly.

To fix the problem, click Fix It For Me to have AOL automatically go through the steps to correct the 
problem.
If the problem continues, try one or all of the following:

· Clear the cache.
· Quit other open programs.

 

Clearing the cache 
AOL's built-in browser temporarily stores images and text from World Wide Web pages on your hard 
drive in a storage area called a cache. When the cache fills up, performance can slow down, and your 
hard drive may run out of space.
To clear the cache

1 Click Settings on the AOL toolbar. 
2 Click Internet Properties.
3 Under Related Settings, click Internet Explorer Settings.
4 In the Temporary Internet files section, click Delete Files.
5 Click OK. 

Quitting other open programs 
1 Click inside a window of an open program, or, if no windows are visible, click a program's 

button on the taskbar (the taskbar contains the Start button and appears by default at the bottom 
of the desktop). 

2 On the File menu of the program, click Exit.



An AOL error has occurred [1]
Your AOL software is currently not working correctly.

To fix the problem, try this first: 
· AOL Auto Fix: Click Fix It For Me to have AOL automatically go through the steps to 

correct the problem.

If the problem continues, try one or all of the following: 
· Clear the cache.
· Reinstall your AOL software.

Clearing the cache
AOL's built-in browser temporarily stores images and text from World Wide Web pages on your hard 
drive in a storage area called a cache. When the cache fills up, performance can slow down, and your 
hard drive may run out of space.
To clear the cache

1 Click Start on the Windows taskbar.
2 Click Control Panel.
3 Double-click Internet Options.
4 In the Temporary Internet files section, click Delete Files.
5 Click OK.

Reinstalling your AOL software
1 Insert an AOL CD-ROM into your CD-ROM drive.
2 On the Windows Start menu, click Run. 
3 Type d:\setup (or e:\setup), then press ENTER.



An AOL error has occurred [2]
Your AOL software is currently not working correctly. 
 
To fix the problem, try this first: 

· Quit all other programs that are running on your computer.

To quit other programs
1 Click a program's button on the taskbar (the bar that contains the Start button and appears by 

default at the bottom of the desktop). 
2 On the File menu of the program, click Exit.
3 Repeat steps 1 and 2 for all programs other than AOL.

If the problem continues, try one or all of the following: 
· Clear the cache.
· Reinstall your AOL software.

Clearing the cache 
AOL's built-in browser temporarily stores images and text from World Wide Web pages on your hard 
drive in a storage area called a cache. When the cache fills up, performance can slow down, and your 
hard drive may run out of space.

To clear the cache
1 Click Start on the Windows taskbar.
2 Click Control Panel.
3 Double-click Internet Options.
4 In the Temporary Internet files section, click Delete Files.
5 Click OK.

Reinstalling your AOL software 
1 Insert an AOL CD-ROM into your CD-ROM drive.
2 On the Windows Start menu, click Run. 
3 Type d:\setup (or e:\setup), then press ENTER.



An AOL error has occurred [3]
Your AOL software is currently not working correctly. 

To fix the problem, try this first: 
· Use Quick Restore to reset your AOL software to a default state:

To use Quick Restore
1 Click the Start menu.
2 Navigate through the menus and point to the America Online® program folder, then click the 

AOL System Information menu item.
3 Click the Quick Restore button near the bottom of the tab.
4 Click OK to proceed.

If the problem continues, try the following: 
· Reinstall your AOL software.

To reinstall your AOL software
1 Insert an AOL CD-ROM into your CD-ROM drive.
2 On the Windows Start menu, click Run. 
3 Type d:\setup (or e:\setup), then press ENTER.



An AOL error has occurred [4]
Your AOL software is currently not working correctly. To fix the problem, try this first: 

· Quit all other programs that are running on your computer.
To quit other programs

1 Click a program's button on the taskbar (the bar that contains the Start button and appears by 
default at the bottom of the desktop). 

2 On the File menu of the program, click Exit.
3 Repeat steps 1 and 2 for all programs other than AOL.

If the problem continues, try the following: 
· Restart the AOL software.

Restarting your AOL software 
1 From the AOL File menu, click Exit.
2 Click Start, point to the America Online program folder, and click the America Online menu 

item.

If the problem continues, try the following: 
· Restart your computer.

Restarting your computer
1 Click Start, and then click Shut Down. 
2 In the What do you want the computer to do drop-down list, click Restart.

If the problem continues, try the following: 
· Use Quick Restore to reset your AOL software to a default state.

To use Quick Restore
1 Click the Start menu.
2 Navigate through the menus and point to the America Online program folder, then click the 

AOL System Information menu item.
3 Click the AOL Applications tab.
4 Click Open Quick Restore.
5 Click Yes to proceed.

If the problem continues, try the following: 
· Reinstall your AOL software.

To reinstall your AOL software
1 Insert an AOL CD-ROM into your CD-ROM drive.
2 On the Windows Start menu, click Run. 
3 Type d:\setup (or e:\setup), then press ENTER.





Buddy List® error
Your Buddy List cannot be displayed. 
To fix the problem so that your Buddy List window displays

1 On the AOL Toolbar, click Settings. 
2 On the Essentials tab, click Buddy List Setup. 
3 Click IM Settings. 
4 Click the General Buddy tab. 
5 Click Show me my Buddy List at sign-on so that a check mark appears.
6 Click Save.

If the problem continues, try the following: 
· Restart the AOL software.

Restarting your AOL software 
1 From the AOL File menu, click Exit.
2 Click Start, point to the America Online program folder, and click the America Online menu 

item.



Navigation action cancelled
The connection to the Internet may have been interrupted by another program. To fix the problem, try 
again. If the problem continues: 

Clear the browser cache 
AOL's built-in browser temporarily stores images and text from World Wide Web pages on your hard 
drive in a storage area called a cache. When the cache fills up, performance can slow down, and your 
hard drive may run out of space.
To clear the cache

1 Click Settings on the AOL toolbar. 
2 Click Internet Properties.
3 Under Related Settings, click Internet Explorer Settings.
4 In the Temporary Internet files section, click Delete Files.
5 Click OK. 

If the problem continues: 
· Use AOL Auto Fix.

Using AOL Auto Fix 
· Click Fix It For Me to have AOL automatically go through the steps to correct the problem.



Not enough disk space
The amount of available disk space is insufficient to complete the requested task. To fix the problem, 
try one or more of the following:

· Delete unneeded files from your computer.
· Delete stored artwork from your computer.

 

Deleting unneeded files from your computer 
Use Windows Disk Cleanup to free up space on your hard drive. Disk Cleanup enables you to delete 
unnecessary program files, temporary files, and Internet cache files.

To open Disk Cleanup
1 Click Start. 
2 Navigate to the Programs menu and point to Accessories.
3 Point to System Tools.
4 Click Disk Cleanup.

Deleting stored artwork from your computer
After an extended period of time, the amount of stored artwork on your computer can reduce 
efficiency. You can delete the artwork by resetting the amount of space AOL uses to store online art. 
To delete stored artwork from your computer:

1 Click Settings on the AOL toolbar.
2 Click the A-Z tab.
3 Scroll down the list and click Font, Text, and Graphics.
4 In the Graphics Settings section at the bottom of the window, use the arrows to set the maximum

disk space used for online art to 5 megabytes.
5 Click Save.
6 If you are signed on, sign off of the AOL service, then sign back on (the stored artwork will not 

be deleted until you sign off). 
7 Click Settings.
8 Click the A-Z tab.
9 Scroll down the list and click Font, Text, and Graphics.
10 Click Reset.
11 Click Save.

 



Not enough memory
AOL needs more memory to complete the requested task. If the problem continues, try one of the 
following:

· Quit other open programs
· Delete stored artwork from your computer

Quitting other open programs 
1 Click inside a window of an open program, or, if no windows are visible, click a program's 

button on the taskbar (the taskbar contains the Start button and appears by default at the bottom 
of the desktop).

2 On the File menu of the program, click Exit. 

Deleting stored artwork from your computer
If the problem continues, delete stored artwork to make additional memory available.
To delete stored artwork from your computer

1 Click Settings on the AOL toolbar.
2 Click the A-Z tab.
3 Scroll down the list and click Font, Text, and Graphics.
4 In the Graphics Settings section at the bottom of the window, use the arrows to set the maximum

disk space used for online art to 5 megabytes.
5 Click Save.
6 If you are signed on, sign off of the AOL service, then sign back on (the computer deletes the 

stored artwork when you sign off). 
7 Click Settings.
8 Click the A-Z tab.
9 Scroll down the list and click Font, Text, and Graphics.
10 Click Reset. 
11 Click Save.



Not enough memory (disk space)
The amount of disk space currently available on your system is insufficient for AOL to function 
properly.
To fix the problem, try clearing the cache. AOL's built-in browser temporarily stores images and text 
from World Wide Web pages on your hard drive in a storage area called a cache. When the cache fills 
up, performance can slow down, and your hard drive may run out of space. 
To clear the cache

1 Click Settings on the AOL toolbar. 
2 Click Internet Properties.
3 Under Related Settings, click Internet Explorer Settings.
4 In the Temporary Internet files section, click Delete Files.
5 Click OK. 

If the problem continues, try deleting unneeded files from your computer. 

Deleting unneeded files from your computer
Use Windows Disk Cleanup to free up space on your hard drive. Disk Cleanup enables you to delete 
unnecessary program files, temporary files, and Internet cache files.
To open Disk Cleanup

1 Click Start. 
2 Navigate to the Programs menu and point to Accessories.
3 Point to System Tools.
4 Click Disk Cleanup.



Not enough memory (RAM)
The amount of memory currently available on your system is insufficient for AOL to function properly.
To fix the problem, try one or all of the following: 

· Quit other open programs.
· Restart your AOL software.
· Restart your computer.

 
Quitting other open programs 

1 Click inside a window of an open program, or, if no windows are visible, click a program's 
button on the taskbar (the taskbar contains the Start button and appears by default at the bottom 
of the desktop).

2 On the File menu of the program, click Exit. 

Restarting your AOL software 
1 From the AOL File menu, click Exit.
2 Click Start, point to the America Online program folder, and click the America Online menu 

item.

Restarting your computer
1 Click Start, and then click Shut Down. 
2 In the What do you want the computer to do drop-down list, click Restart.



Page cannot be displayed
This may be due to a software problem. To fix the problem, try again. If the problem continues: 

Clear the browser cache 
AOL's built-in browser temporarily stores images and text from World Wide Web pages on your hard 
drive in a storage area called a cache. When the cache fills up, performance can slow down, and your 
hard drive may run out of space.
To clear the cache

1 Click Settings on the AOL toolbar. 
2 Click Internet Properties.
3 Under Related Settings, click Internet Explorer Settings.
4 In the Temporary Internet files section, click Delete Files.
5 Click OK.

If the problem continues: 
Quit other open programs 

1 Click inside a window of an open program, or, if no windows are visible, click a program's 
button on the taskbar (the taskbar contains the Start button and appears by default at the bottom 
of the desktop). 

2 On the File menu of the program, click Exit.
3 Repeat steps 1 and 2 for all programs other than AOL.

If the problem continues: 
Use AOL Auto Fix 

· Click Fix It For Me to have AOL automatically go through the steps to correct the problem.



Response from the service is delayed
The service is busy or unable to immediately respond. You may not be able to access a service, such as 
e-mail or newsgroups, as quickly as usual. To fix the problem:

· Try again. The service may have been temporarily busy. If the problem persists, wait a few 
minutes then try again.

If the problem continues, follow the steps below to exit other open programs.
Quitting other open programs 

1 Click inside a window of an open program, or, if no windows are visible, click a program's 
button on the taskbar (the taskbar contains the Start button and appears by default at the bottom 
of the desktop).

2 On the File menu of the program, click Exit. 



Restarting America Online
The AOL program may encounter an error condition and shut down automatically. When it does, the 
main AOL window closes and a dialog box labeled Restarting America Online appears on your 
screen. At this point, you can choose to do one of the following:

· Return to your AOL session
· Sign off of the AOL service
· See technical details about the error that AOL encountered

To return to your AOL session
· Wait while the AOL program attempts to start back up automatically. If AOL successfully 

restarts, you can resume your AOL session.
OR

1 Click OK in the Restarting America Online dialog box. The AOL program attempts to start 
back up automatically. If AOL successfully restarts, the dialog box will display Success.

2 Click OK to return to your AOL session.

If AOL is not successful in automatically restarting, the dialog box displays a flashing Error message. 
Click OK to return to the Sign On screen, where you can start the AOL service.

To sign off the AOL service
· Click Sign Off.

To see the technical details of the error AOL encountered
1 Click Details.
2 Click OK when you are done reviewing the details.



The main.idx database file is damaged
A file, main.idx, needed for your AOL software to work properly, is damaged. To fix the problem, 
reinstall your AOL software. 

To reinstall your AOL software
1 Insert an AOL CD-ROM into your CD-ROM drive.
2 On the Windows Start menu, click Run. 
3 Type d:\setup (or e:\setup), then press ENTER.



File Unavailable
We're sorry, but the fix you selected could not be found on this computer.

· If you can sign on to the AOL service, go to AOL Keyword: Fix It to find the automatic fix 
you tried to run.

· If you cannot sign on, call AOL Technical Support toll-free at 1-800-827-6364.
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About Computer Viruses
If you download files or e-mail attachments, exchange floppy disks with other people, or use the 
Internet frequently, your computer is at risk from viruses and Trojan Horse programs. Virus-checking 
software can help prevent serious problems.

What is a computer virus?
Computer viruses are small programs that can reproduce themselves and spread from one computer to 
another when people exchange files. Some viruses do nothing more than fill up space on your 
computer's hard drive. Other viruses can destroy critical data on your computer.

What Is a Trojan Horse program?
A Trojan Horse is a program that appears to function normally, but contains hidden instructions that 
cause damage (sometimes severe) to your computer. Trojan Horse programs may compromise the 
security of your AOL account, contain objectionable graphics, or cause damage to your computer files.

How to help avoid computer viruses and Trojan Horse programs
Get anti-virus software and use it. AOL offers an excellent anti-virus program. McAfee VirusScan is 
included with your AOL software. Sign on to AOL and go to AOL Keyword: AntiVirus. There you can 
get assistance with your virus questions.
In addition to making sure you have anti-virus software, don't open file attachments from strangers. If 
you use Automatic AOL to download your e-mail, consider not automatically downloading attached 
files. You can download attachments once you know who sent them, and you'll still be able to 
automatically retrieve e-mail messages.
Back-up important files -- correspondence, contact names and addresses, working notes, and 
manuscripts -- regularly.
Run your own virus-check on any file you download. AOL is one of the safest file sources anywhere, 
and many of the files in AOL's download libraries have already been scanned with the latest anti-virus 
software. Files you download from the Internet or receive in e-mail cannot be scanned by AOL.
If you exchange floppy disks, virus-check your floppies. You don't know how careful -- or how lax -- 
others are about avoiding computer viruses.

To get the latest virus protection tips and software, sign on and go to AOL Keyword: AntiVirus.

For more information, see:
About Trojan Horse Programs 
E-Mail Scams and Schemes 
About McAfee Virus Scan 



About Trojan Horse Programs
A Trojan Horse is a program that appears to perform a valid function but contains, hidden in its code, 
instructions that cause damage (sometimes severe) to your computer. Trojan Horse programs may 
compromise the security of your AOL account, contain objectionable graphics, or cause damage to 
your computer files.

Help to protect yourself
You can help to avoid most Trojan Horse programs by NEVER downloading a file attached to an e-
mail from someone you don't know.

Obtaining anti-virus software
Anti-virus programs come with a database of information on thousands of known viruses. The program
looks through all the data on your hard drive to see if anything matches a pattern in that database. Since
new viruses are constantly appearing, your anti-virus program must be regularly updated. Most anti-
virus software publishers release updates to their software containing information on new viruses every
few months.
For more information about your anti-virus software, see McAfee VirusScan Help.

For more information, see:
About Computer Viruses 
E-Mail Scams and Schemes 
About McAfee Virus Scan 



E-Mail Scams and Schemes
Junk e-mail is any unsolicited advertising, promotional material, or other forms of solicitation 
masquerading as an e-mail message. In addition to being a nuisance, junk mail can carry dangerous 
Trojan Horse programs. These programs come to your mailbox as e-mail attachments disguised as 
software, screen savers, photos or some other offer of free products. If you mistakenly download one of
these attachments, the Trojan Horse program could capture your password and mail it back to the 
hacker's e-mail address. NEVER download files from someone you don't know!
Hackers risk permanent cancellation of their AOL memberships. If you receive junk mail, either with 
or without attachments, sign on to AOL, open your mailbox and click the item of e-mail you wish to 
report, and then click Report Spam.
For more information on the latest scams and schemes, sign on to AOL and go to AOL Keyword: 
Neighborhood Watch. You can also call AOL for the latest information on online scams at 1-888-265-
3733.

For more information, see:
About AOL's Terms Of Service 
About AOL Keyword: Notify AOL 
About Computer Viruses 
About Trojan Horse Programs 
About McAfee Virus Scan 



About Parental Controls
Parental Controls enable the primary master account holder (the first screen name that you created 
when you registered your America Online account) to restrict access to certain areas and features on 
America Online for one or all of the screen names on the account.
Once Parental Controls have been set for a particular screen name, they are active each time that screen
name signs on. The master account holder can make changes to these controls at any time. The master 
account holder may also designate Master Screen Name status for up to 2 additional existing or newly 
created screen names besides the primary master screen name. Any Master Screen Name can 
set/change Parental Controls for any other screen name, so this capability should not be given to screen
names used by children.
Sign on to AOL and go to AOL Keyword: Parental Controls to familiarize yourself with the controls 
that are available to help you make your child's online experience a more safe and more positive one.

For more information, see:
About AOL's Terms Of Service 
About AOL Keyword: Notify AOL 



About AOL's Terms of Service
The foundation of AOL's relationship with members is the Terms of Service or TOS. The TOS contains
AOL's commitments to you, as well as your rights and responsibilities as an AOL member.
To read the AOL Terms of Service agreement, sign on to AOL, and go to AOL Keyword: Terms of 
Service.

For more information, see:
About AOL Keyword: Notify AOL 
E-Mail Scams and Schemes 



About AOL Keyword: Notify AOL
If you witness any inappropriate activity by other members while signed onto AOL, report it at Notify 
AOL (AOL Keyword: Notify AOL.)

At AOL Keyword: Notify AOL:
1 Click Chat to report vulgar language and disruptive behavior in chat rooms.
2 Click E-Mail & Attachments to learn how to report e-mail from strangers that contains 

attached files or requests for your password, credit card number, or other personal information.
3 Click Instant Message Notes if you receive requests for your password or observe disruptive 

behavior in an Instant Message note.

Notes
· Problems in online areas such as message boards, member profiles, or Web pages can be 

reported by clicking on the Message Boards, Web Pages, or Screen Names & Profiles 
buttons, respectively.

· Your report will be sent to AOL's Community Action Team (CAT). CAT will review this 
report and take action against the members responsible if the activity shows a violation of 
AOL's Terms of Service. Our options include both written warnings and account termination
if necessary. All reports of TOS violations are processed within 48 hours.

For more information, see:
About AOL's Terms Of Service 
About Parental Controls  



About Your Password
Anyone who knows your screen name and password can use your account. America Online employees 
will never ask for your password. Your password should be easy for you to remember, but difficult for 
others to guess. As an extra precaution, you should change it often (sign on to AOL and go to AOL 
Keyword: Password). The most secure type of passwords include combinations of letters and numbers.

NEVER REVEAL YOUR PASSWORD TO ANYONE

For more information, see:
Changing Your Password 
Password Requests in E-Mail 
Password Stealing Schemes 



Changing Your Password
1 Click the Settings icon on the AOL toolbar. The Settings window opens.
2 In the AOL Settings window, click By Category.
3 Under the By Category tab, click Safety, Security, & Privacy.
4 Click Password Reset.
5 Click Change Password.
6 In the Change Your Password window, type your old password in the Current password: box.
7 Type your new password in both the Enter new password twice: boxes.
8 Click Change Password.

If you are tricked into revealing your password:
Online scam artists can succeed in tricking even the most seasoned cyber-veteran. Immediately change 
your password. Before you sign off, change your password for your screen name. Also change the 
passwords for any other screen names on your account.
If you downloaded a suspicious file that you suspect may have a Trojan Horse program, call AOL 
Customer Service immediately at 1-800-827-6364.

Notes
· Anyone who knows your password and screen name can sign on to your account. No one 

from America Online will ever ask you for your password. You should never reveal your 
password to anyone.

· Use different passwords for each screen name on your account.
· Never download files attached to an e-mail from someone you don't know. These files may 

contain "Trojan Horse" programs that can give your password to scam artists without your 
knowledge.

· You should change your password frequently.
· Report all e-mail password solicitations by signing on to AOL, opening your mailbox and 

clicking the mail with the password solicitation once to select it, and then clicking Report 
Spam. Report other password solicitations -- via Instant Messages, for example -- at AOL 
Keyword: Notify AOL.

For more information, see:
About Your Password 
Password Stealing Schemes 
Password Requests in E-Mail 
E-Mail Scams and Schemes 



Password Requests in E-Mail
AOL staff will never ask you for your password.
If you receive official-looking e-mail -- supposedly from an AOL staff person -- do not give out 
information about your password or billing (credit card) information. It's the virtual equivalent of 
handing your house keys to a stranger.
If you receive suspicious e-mail, sign on to AOL, open your mailbox and click once on the e-mail to 
select it, and then click Report Spam. 
For more information on the latest scams and schemes, sign on to AOL and go to AOL Keyword: 
Safety. You can also call AOL for the latest information on online scams at 1-888-265-3733.

For more information, see:
About Your Password 
Password Stealing Schemes 
Changing Your Password 



Password Stealing Schemes
One of the most important things to remember about your AOL password is to keep it a secret. Anyone 
who knows your password has access to your AOL account and can pose as you in chat rooms, send e-
mail in your name, or shop online leaving you with the bill.
There are four general categories of password stealing schemes intended to trick you (or your 
computer) into revealing your password. If you receive a suspicious e-mail, sign on to AOL and open 
your mailbox, click the e-mail once to select it, and then click Report Spam. If you receive a 
suspicious instant message note, click Notify AOL.
Here are some common scams you should be aware of:

The So-Called Online Technical Consultant
This is someone posing as an AOL Consultant and claiming to offer you help with problems relating to 
passwords, line noise, hackers, or other technical problems. What they really want is to help 
themselves to your password. AOL staff will never ask you for your password.

The So-Called Hacker Enforcer
Although AOL does have employees who work to prevent hacking, they would never contact you via 
the AOL® Instant MessagerTM feature or in a private chat room. AOL staff will never ask you for 
your password.

The So-Called Billing, Credit, or Community Action Team (CAT) Department
Again, we obviously have a billing department, but would never try to conduct these types of inquiries 
using the AOL® Instant MessagerTM feature. 

The Trojan Horse Programs
Trojan horse programs arrive to your mailbox as e-mail attachments disguised as software, screen 
savers, photos or some other offer of free products. If you mistakenly download one of these 
attachments, the Trojan Horse program may contain a virus that will damage files on your computer, or
it may capture your password and mail it back to the hacker's e-mail address. If you receive a 
suspicious e-mail with a file attachment, DO NOT DOWNLOAD THE FILE. Instead, sign on to AOL, 
open your mailbox and click the suspicious mail once to select it, and then click Report Spam. Never 
download files sent to you from people you don't know!

For more information, see:
About Your Password 
Password Requests in E-Mail 
E-Mail Scams and Schemes 
Changing Your Password 



What if I forget my AOL password?
To reset your password

1 Start the AOL software and on the Sign On screen choose the screen name for which you have 
forgotten your password from the Select Screen Name list.

2 Click Forgot Password.
3 Click Yes, confirm that you have the information listed on the Verifying Your Account window,

and then click Continue.
4 Type the information requested to verify you are an authorized account user, and then click OK.
5 Type your new password twice in the spaces provided, and then click OK.

Notes
· If you are unable to reset your password online, or if you are not the billing contact on the 

AOL account, then the billing contact for the account needs to call Member Services for 
password resets. The billing contact for the AOL account is the person whose name appears 
on the method of payment. If you are a US AOL member, call 1-800-827-6364. If you are a 
Canadian AOL member, call 1-888-265-6304.

· You have two opportunities to provide the correct information to verify that you are an 
authorized account user.

· If you have had the AOL software remember your password, you need to remove the stored 
password so you can sign on with your new password.

For more information, see:
Storing Your Password 
Changing Your Password 



Storing Your Password
You can store your password so you don't have to type it in every time you sign on.
To store your password from the Sign On screen

1 On the AOL Sign On screen, select the screen name you want to store a password for from 
the screen name menu. 

2 Type the password for that screen name in the password field. 
3 Select the Save Password check box. The next time you sign on to AOL, your password will 

be stored on the Sign On screen.
Notes

· If you store your password, anyone with access to your computer can sign on to your account.
· Any violations of AOL's Terms of Service committed under your screen name are subject to 

TOS action, whether you were behind the keyboard or not. 
· If you want to have your Filing Cabinet "locked" (so you have to enter your password to open

it), select the Mail Saved on My PC check box on the Password Preferences form.



AOL Spyware Protection
If your computer is connected to the Internet, chances are you have unsolicited software on your PC 
called spyware or adware. These programs are like viruses and are "attached" to software you have 
downloaded, e-mail messages, or Web sites you have visited. All of this happens without you even 
knowing it. Annoying pop-up ads, mysterious new toolbars, a slow PC, and new icons in your system 
tray are all signs that your computer is infected with these malicious. Although these programs are not 
as dangerous as viruses, they can slow down your computer and invade your privacy by monitoring 
where your browse the Internet.
AOL Spyware Protection helps protect your computer by scanning your system for known spyware 
and adware programs, and removing them.
To use AOL Spyware Protection

1 From the AOL System Tray icon, click AOL Spyware Protection… . The AOL Spyware 
Protection window opens.

2 Click Scan Now to scan your system.

For more information about how AOL Spyware protection works, click Help from the AOL Spyware 
Protection window.



spyware
Spyware is similar to adware but much more dangerous by actually scanning your hard drive for 
personal information and attempting to link your web browsing habits to your e-mail address. Once it 
has discovered your e-mail address, you fall victim to all the spam and junk e-mail that litter your 
inbox.



adware
Adware is any software that once installed on your computer tracks your Web browsing and sends you
pop-ups containing advertisements related to your browsing habits. While these may seem innocent, 
you are paying the price by sacrificing much-needed processor speed and internet connection speed.



About McAfee Virus Scan
Because there are about 300 new computer viruses found each month, you need to protect your 
computer from infection. AOL helps makes sure you’re protected by offering McAfee VirusScan 
software for those who don’t already have anti-virus software on their computers. Once McAfee 
VirusScan is installed, your PC is protected from known viruses with regular, automatic updates when 
you connect to the internet.

To get the latest virus protection tips and software, sign on and go to AOL Keyword: AntiVirus.

To find out more about using your McAfee anti-virus software, see McAfee VirusScan Help.

For more information:
About Computer Viruses 
About Trojan Horse Programs 
E-Mail Scams and Schemes 



Checking Your Current AOL Bill
1 Sign on to the America Online service.
2 Go to AOL Keyword: Billing.
3 Select an option under the View Your Bill section:

· Click Display Your Current Bill Summary to view a summary of your current month's 
bill.

· Click Display Your Detailed Bill to view your current or last month's bill by line item.
· Click Display Billing Date and Price Plan Info to see your next billing date, monthly fees,

and Free minutes each month, if applicable.

Note
At AOL Keyword: Billing, you can also update your billing information and price plan.

For more information, see:
Updating Your Billing Information 



Updating Your Billing Information
1 Sign on to the America Online service.
2 Go to AOL Keyword: Billing.
3 Select an option under the Update Your Info section:

· Click Change your Name or Address to update your personal information.
· Click Change your Billing Method or Price Plan to update your payment method or your 

pricing plan.

Note
At AOL Keyword: Billing, you can also view your AOL bill.

For more information, see:
Checking Your Current AOL Bill 



Calling AOL Technical Support
· For technical support, billing, and other account inquiries, call 1-800-827-6364.
· For hearing impaired members, our TTY number is 1-800-759-3323 (within the U.S. and 

Canada).



About E-Mail
Electronic mail (e-mail) allows you to exchange messages, documents, photographs, even sounds, with
anyone with an e-mail address, virtually anywhere in the world, virtually instantaneously.
There is no extra charge for sending or receiving e-mail on AOL.
If you have e-mail waiting for you when you sign on to the America Online service, the flag on the 
mailbox on the "Welcome Screen" will be up. If your computer has a sound card, you will also hear 
"You've got mail."
You can also send and receive your AOL e-mail directly from the Web, with AOL Mail on the Web. For
more information, sign on to the AOL service and go to AOL Keyword: AOL Mail on the Web.



Writing E-Mail When You Are Not Signed On
1 Click the Write icon on the AOL toolbar.
2 In the Send To: box, type the e-mail address of the person you want to send e-mail to. (To send 

the same message to another person, type a comma and add the next e-mail address.)
3 In the Subject: box, type a subject line for your e-mail.
4 Type your message in the large message box.
5 When you have finished, click Send Later.

Notes
· E-Mail addresses that are stored in your Address Book will be automatically completed for 

you as you type. When there is more than one possible matching address, a list of 
suggestions will appear below the Send To: or Copy To: box. 

· You must be signed on to the AOL service to send the e-mail that you compose offline. 
When you click Send Later, your e-mail will be stored in the "Mail Waiting To Be Sent" 
subfolder (within the Saved On My PC mail folder) until you sign on or until you activate 
Automatic AOL to send your outgoing e-mail. The Send Later button is not active when 
you are signed on as a guest.

· You can click Address Book to choose your recipients. Open your Address Book, click the 
desired name, then click the Send To button. (You can also send a copy or blind copy).

· To add more than one e-mail address in the Send To: or Copy To: boxes, separate them 
with a comma; for example: aolmember1, aolmember2, aolmember3.

For more information, see:
About E-Mail 
Sending Courtesy Copies 
Sending Blind Copies 
Using Your Address Book To Send E-Mail 



Your E-Mail Address
Your e-mail address for correspondence with other members of America Online is your screen name.

· For example: AOLMember1
Your e-mail address for correspondence from outside of America Online (such as through the Internet 
or another online service) is your screen name (without any capitalization or spaces) followed by 
@aol.com

· For example: aolmember1@aol.com

Notes
· You can create different screen names for different purposes (for example, one to use with 

friends and one to use for business), or you can assign a separate screen name (and private 
mailbox) to each of the members of your family.

· You can have up to seven screen names on your AOL account at no extra charge. To create 
or delete a screen name, sign on to the AOL service using your master screen name and go 
to AOL Keyword: Names.

· When you delete a screen name, you also delete its mailbox, and any e-mail that is 
subsequently sent to that screen name will be returned to the person who sent it.

For more information, see:
About E-Mail 
Using Your Address Book to Send E-Mail 



Sending Blind Copies
Send blind copies of your e-mail when you do not want the primary addressee(s) to know that you have
sent the e-mail to anyone else.
To send a blind copy:

1 Click the Write icon on the AOL toolbar.
2 In the Send To: box, type the e-mail address(es) of the primary recipient(s).
3 In the Copy To: box, type the e-mail address(es) of the recipient(s) of blind copies in 

parentheses, for example: (aolmember1, aolmember2, aolmember3)
4 In the Subject: field, type a subject line for your e-mail.
5 In the message box, type your e-mail message.
6 When you have finished, click Send Later.

Notes
· All of the recipients of your e-mail can receive blind copies: you do not have to designate a 

primary recipient. Recipients of blind copies will not see the names of others who received 
blind copies.

· As the sender of the e-mail, you will always see all names on the e-mail (even those who 
received blind courtesy copies) -- whether you look in your online mailbox, or in your 
offline mailbox, or if one of the e-mail recipients forwards a copy of the e-mail back to you.

· You must be signed on to the AOL service to send the e-mail you compose offline. When 
you click Send Later, your e-mail will be stored in your offline mailbox until you sign on 
to the AOL service or until you activate Automatic AOL to send your outgoing e-mail. The 
Send Later button is not active when you are using the Guest feature.

· You can click Address Book to choose your recipients. Open your Address Book, click the 
desired name, click Send, and then choose Blind Copy. 

· To add more than one e-mail address in the Send To: or Copy To: boxes, separate them 
with a comma; for example: aolmember1, aolmember2, aolmember3.

For more information, see:
About E-Mail 
Using Your Address Book To Send E-Mail 
Sending Courtesy Copies 



Sending Courtesy Copies
Send a courtesy copy (or carbon copy) of your e-mail when there are people other than the primary 
addressee(s) who also have an interest in the subject of the e-mail.
To send a courtesy copy

1 Click the Write icon on the AOL toolbar.
2 In the Send To: box, type the e-mail address(es) of the primary recipient(s).
3 In the Copy To: box, type the e-mail address(es) of the recipient(s) of courtesy copies.
4 In the Subject: field, type a subject line for your e-mail.
5 In the message box, type your e-mail message.
6 When you have finished, click Send Later.

Notes
· You must be signed on to the AOL service to send the e-mail you compose offline. When 

you click Send Later, your e-mail will be stored in your offline mailbox until you sign on 
to the AOL service or until you activate Automatic AOL to send your outgoing e-mail. The 
Send Later icon is not active when you are using the Guest screen name.

· You can click Address Book to choose your recipients. Open your Address Book, click the 
desired name, then click the Copy to button.

· To add more than one e-mail address in the Send To: or Copy To: boxes, separate them 
with a comma; for example: aolmember1, aolmember2, aolmember3.

For more information, see:
About E-Mail 
Using Your Address Book To Send E-Mail 



Requesting a Return Receipt
1 Click the Write icon on the AOL toolbar.
2 Address your e-mail as usual.
3 Select the Request "Return Receipt" from AOL members check box.
4 Type your message and send your e-mail as usual.

Notes
· You will receive an e-mail notification when each AOL member opens your e-mail.
· You will not receive a return receipt for e-mail you send to Internet addresses.

For more information, see:
About E-Mail 
Using Your Address Book To Send E-Mail 
Sending Courtesy Copies 
Sending Blind Copies 



About MIME
MIME (Multipurpose Internet Mail Extension) is a specification, or a set of guidelines, that software 
must use in order to work with other software. When you send an attachment with an e-mail message 
from AOL to someone over the Internet, MIME helps ensure that the recipient gets your attachment in 
a readable format -- whether the attachment includes graphics, sounds, or whatever you choose to send.
On AOL, all you do is click Attach File on your e-mail form, and the AOL software automatically 
does the rest. Likewise, when you receive a MIME-encoded attached file from an Internet address, the 
AOL software will decode the file for you -- automatically. The AOL software is what is known as 
MIME-compliant. As long as your correspondents also have e-mail software that is MIME-compliant 
(and most email software is), you can swap files.
Note

Occasionally, you might need to decode a MIME file yourself with MIME decoder software. 
You can download MIME decoder software from the following sites: 
· Freeware and shareware: AOL Download Center 

· Free to try: www.winzip.com

For more information, see:
About Zipped (Compressed) Files 



Reading E-Mail
1 Click the Read icon on the AOL toolbar.
2 Select a mailbox folder that contains e-mail. When you aren’t signed in, only the Saved on My 

PC mailbox folder is accessible. It contains the following kinds of e-mail:
· E-Mail that you have saved
· E-Mail that you want to send later
· E-Mail that you’ve sent
· New e-mail that you retrieved using Automatic AOL.

3 Click an e-mail to view it in the Quick Read pane or double-click to read it.

Notes
· Previewing mail is only enabled if you have set your screen resolution to 1024 x 768 or 

higher. 
· You can close the Quick Read pane by clicking the left arrow button on the right side of the 

Quick Read pane. If the Quick Read pane is closed, click the right arrow button on the right 
side of the mailbox window to show it.

· To show the mail header of an e-mail in the Quick Read pane, click the down arrow at the 
top of the Quick Read pane. Click the up arrow at the top of the Quick Read pane if you 
don’t want to see the mail header.

· You can set a mail preference to keep e-mail in your online mailbox for up to seven days 
after it has been opened.

For more information, see:
About E-Mail 
About Automatic AOL 
Reading and Responding to E-Mail When You're Not Signed On 



Reading and Responding to E-Mail When You're Not Signed On
1 Click the Read icon on the AOL toolbar.
2 Click the Saved on My PC folder if it is not already open.
3 Click the Incoming/Saved Mail folder.
4 Open an e-mail you want to read.
5 Highlight a section of text to select it, if you want to quote it in your response.
6 Click Reply (or Forward).
7 Add your response to the quoted material.
8 Click Send Later. Your e-mail response will be stored in your Mail Waiting To Be Sent mailbox

folder until you sign on to the AOL service or until you activate Automatic AOL to send your 
outgoing e-mail.

For more information, see:
About E-Mail 
About Automatic AOL 
Using Automatic AOL to Read E-Mail Offline 



Saving E-Mail to Your Computer or a Disk
1 Sign on to the America Online service.
2 Click the Read icon on the AOL toolbar.
3 Click the Manage Mail tab to bring mail to the front that you have already read.
4 Double-click e-mail that you want to save, to open it.
5 On the File menu, click Save As.
6 In the Save As window, navigate to the folder on your computer where you want the e-mail to 

be stored.
7 Type a filename for your e-mail in the Filename: box. (You should make a note of where you 

store the mail and the name you give it so that you can find it easily later.)
8 Click Save.

For more information, see:
About E-Mail 



Sorting the Contents of Your Mailbox
You can now sort the messages in your online mailbox by e-mail address, time of arrival, subject 
heading, and type of message (Everyone, People I Know, Bulk Senders, Unknown Senders, as well as 
All Related Mail - Date, Subject, Sender or All of above).

1 Sign on to the AOL service.
2 Click the Read icon on your AOL toolbar.
3 Click one of the column headings (i.e., Type, Date, E-Mail Address, and Subject) to sort your e-

mail. The arrow will indicate whether items are being sorted in ascending or descending order. 
You can also filter the list of mail in your mailbox by type. Click the Show me mail from menu 
and select a header.

 

Note
You can change the way your e-mail is sorted by default by changing your mail preferences.



Using Automatic AOL to Read E-Mail Offline
Click a link below to learn more about that topic.
Setting Up Automatic AOL to Send/Retrieve E-Mail 
Activate Automatic AOL (to retrieve e-mail that is waiting for you).
Reading and Responding to E-Mail When You're Not Signed On 

For more information, see:
About E-Mail 
About Automatic AOL 



About File Attachments
You may send separate files with your e-mail by "attaching" them to your e-mail message. These could
be word processing files, spreadsheets, pictures, audio or video files. Here are some basic rules of 
thumb to follow when attaching files to e-mail.

· The maximum size for a file attachment you can send via e-mail is 16 MB. However, if you 
are sending a large attachment to an Internet recipient, please be aware that many Internet 
service providers only allow file attachments of 1 to 1.5 MB in size.

· For mail you send to AOL recipients, multiple file attachments will be zipped (compressed) 
into a single file by the AOL service before they are sent. The files are unzipped 
automatically after the AOL recipient downloads the attachment or signs off the AOL 
service.

· For mail you send to Internet recipients, multiple files remain as separate attachments and 
are not zipped.

· The recipient must have software that is compatible with your file(s). For example, if you 
send a WordPerfect file, your recipient must have either WordPerfect or a word processing 
program capable of opening WordPerfect files. Also make sure the file is compatible with 
your recipient's computer; a Macintosh machine may not be able to read some Windows 
files, and vice versa.

For more information, see:
Attaching a Single File to E-Mail 
Attaching Multiple Files to E-Mail 
Downloading Files Attached to E-Mail 



Attaching a Single File to E-Mail
1 Click the Write icon on the AOL toolbar.
2 In the Write Mail window, click Attach File.
3 Navigate to the folder that contains the file you want to attach.
4 Double-click the file to attach and click OK.

Notes
· You can also attach files by using your mouse to drag files from a folder on your computer 

to the Mail Attachments list box. The Mail Attachments list box is located just above the 
Attach File and Detach File buttons and below the horizontal separator line.

· You can embed certain files within the body of your message. Use your mouse to drag 
embeddable files from a folder on your computer to the body of the Write Mail window. 
Embeddable files include the following extensions: .htm or .html; .bmp; .txt; .jpg 
or .jpeg; .gif; .art.

· The maximum size for a file attachment you can send via e-mail is 16 MB. Many Internet 
service providers, however, only allow file attachments of 1 to 1.5 MB in size.

· The recipient must have software that can open your file(s). For example, if you send 
someone a WordPerfect file, your recipient must have either WordPerfect or a word 
processing program capable of opening WordPerfect files. Also make sure the file is 
compatible with your recipient's computer; a Macintosh machine may not be able to read 
some Windows files, and vice versa.

· To detach files, click the Detach File button, select the file you want to detach and click 
Detach.

For more information, see:
About File Attachments 
Attaching Multiple Files to E-Mail 



Attaching Multiple Files to E-Mail
1 Click the Write icon on the AOL toolbar.
2 In the Write Mail window, click Attach File.
3 Navigate to the folder that contains the files you want to attach.
4 Hold down the CTRL key, and click each item you want to select.
5 Click OK.

Notes
· You can also attach files by using your mouse to drag files from a folder on your computer 

to the Mail Attachments list box. The Mail Attachments list box is located just above the 
Attach File and Detach File buttons and below the horizontal separator line.

· You can embed certain files within the body of your message. Use your mouse to drag 
embeddable files from a folder on your computer to the body of the Write Mail window. 
Embeddable files include the following extensions: .htm or .html; .bmp; .txt; .jpg 
or .jpeg; .gif; .art.

· To detach files, click the Detach File button, select the file you want to detach and click 
Detach.

· Hold down the Shift key and click two items to select all items in between.
· Hold down the CTRL key and click a selected item to undo the selection.
· The maximum size for a file attachment you can send via e-mail is 16 MB. Many Internet 

service providers, however, only allow file attachments of 1 to 1.5 MB in size.
· If you attach more than one file to e-mail you send to another AOL member, the AOL 

software automatically compresses your files together into one .zip file for the recipient. The
files are unzipped automatically when the recipient downloads the zip file or signs off the 
AOL service.

· If you attach more than one file to e-mail you send to an Internet recipient, the files remain 
as separate attachments and are not zipped.

· The recipient must have software that is compatible with your file(s). For example, if you 
send someone a WordPerfect file, your recipient must have either WordPerfect or a word 
processing program capable of opening WordPerfect files. Also make sure the file is 
compatible with your recipient's computer; a Macintosh machine may not be able to read 
some Windows files, and vice versa.

For more information, see:
About File Attachments 
Attaching a Single File to E-Mail 



Formatting Options
The text styling toolbar, located just above the box where you type your e-mail message on the Write 
Mail screen, contains a number of formatting features, from text color to centering to bolding. From 
left to right, they are:
Font — Click the Font text box and select the font you want to use. The default font the AOL service 
uses is called Arial. Example: This is a font called Comic Sans MS.
Text Size — Click the Text Size box and select the size you want your text to be. The larger the 
number, the bigger the letters will appear.
Bold — Click the Bold button to make the letters in the highlighted text appear thicker.
Italics — Click the Italics button to make the letters in the highlighted text appear slanted.
Underline — Click the Underline button to underline the highlighted text.
Text Color — Click the Text Color button to change the color of the text.
Background Color — Click the Text Background Color button to change the Background Color of 
text.
Format — Click the button and select one of the following formatting options:
ž Left-justify: Line up all highlighted text with the left margin. 
ž Right-justify: Line up all highlighted text with the right margin.
ž Center: Move all highlighted text lines to the center of the page.
ž Numbering: Create a numbered list. 
ž Bullets: Create a bulleted list.
ž Right Indent: Indent all highlighted lines.
ž Left Indent: Reduce the indentation of all highlighted lines.
ž Horizontal Rule: Insert a horizontal line.
Insert Smiley — Click the button and select an emoticon, ranging from a smiling face to a sad face.

For more information, see:
About E-Mail 
Changing Formatting  



Changing Formatting
1 Highlight the section of text you want to format to select it.
2 Click the formatting feature(s) you want to use from the text styling toolbar.

Notes
· If you select the same color for both the text and the background color, the text will seem to 

disappear. To see the text again, select a different text or background color.
· If you don't select any text before you change the formatting, the new style appears when 

you begin typing.

For more information, see:
About E-Mail 
Formatting Options  



Adding Favorite Place Hyperlinks to E-Mail
If you've found a great spot on the AOL service or the Internet, why not share it with a friend?
To add a Favorite Place hyperlink to e-mail you send:

1 Click the Write icon on the AOL toolbar to open a blank e-mail form, or use the Write Mail 
form for a letter that you've already started.

2 Click the heart icon on the style toolbar (above the message box) and select an item from the 
menu or submenu. The Favorite Place will be inserted into the e-mail

3 Send your e-mail as usual.

Notes
· If you are online when you write your e-mail, you can also drag the heart icon from any 

window title bar directly to your e-mail.
· Older versions of the America Online software cannot display hyperlinks.
· Hyperlinks sent in e-mail to Internet addresses may or may not display, depending on the e-

mail software the recipient uses.

For more information, see:
About E-Mail 
Writing E-Mail When You Are Not Signed On 
 



Adding Pictures to E-Mail
Inserting a picture into your e-mail places the image in the body of your e-mail. Any text you type 
appears above or below the picture.
Adding an image as a background picture in your e-mail fills the background behind your message 
with the picture. Any text you type appears on the background picture.

1 Click the Write icon on the AOL toolbar.
2 Click the camera icon on the style toolbar (above the message box) and select either Insert 

Picture or Insert Background from the menu that appears.
3 In the Insert Pictures in Mail window, navigate to the folder that contains the image file.
4 Choose the picture(s) you want to insert by clicking the check box next to the picture (or click 

Select All). 
5 Click Insert to add your selected picture(s) into your e-mail message. 
6 Position your cursor before or after the image (Insert Picture) or on the image (Insert 

Background), and type your message.

Notes
· If you insert pictures in e-mail when you are signed on to the AOL service, you will be able 

to create photo layouts in your e-mail message.
· If you want to send an image file to an AOL member who is using an earlier version of the 

software, you will have to attach the file to your e-mail.
· The following file types are supported for pictures: .art, .jpg, .gif, .bmp
· Only Internet users and other members of AOL using version 4.0 or above will be able to 

see the image files you insert in your e-mail.

For more information, see:
About E-Mail 
Attaching a Single File to E-Mail 
About Formatting Options 
Adding Favorite Place Hyperlinks to E-Mail 



Adding a Signature to Your E-Mail
1 Click the Write icon on the AOL toolbar.
2 Address the e-mail as usual.
3 Type your message.

4 Click the Signature button  in the bottom-right corner of the window. A drop-
down list shows your available signatures.

5 Choose a signature from the drop-down list.

Notes
· The signature can be added to the e-mail at any time before you send it.
· You can edit the signature after it has been added to the e-mail without changing the stored 

signature.

For more information, see:
About E-Mail 
Setting Up Signatures in E-Mail 
Selecting a Default Signature 
Turning Off the Default Signature 



Setting Up Mail Signatures
1 On the Mail menu on the AOL toolbar, click Mail Signatures.
2 In the Set up Signatures window, click Create.
3 In the Signature Name box, type a name for this signature (for example; My normal signature).
4 In the Signature box, type the text you want to use as your signature, adding any text styling 

features you want from the style toolbar. You can also insert a picture or other image (BMP, 
JPG, GIF, or ART) if you wish.

5 Click OK.
6 Click the  in the upper right corner to close the Set up Signatures window.

Notes
· You can create and save up to five signatures.
· You can designate one of the signatures as a default signature to be automatically inserted 

into the e-mail message box on all e-mails you write.

For more information, see:
About E-Mail 
Adding a Signature to Your E-Mail 
Selecting a Default Signature 
Turning Off the Default Signature 



Selecting a Default Mail Signature
1 On the Mail menu on the AOL toolbar, click Mail Signatures.
2 In the Set up Signatures window, select the signature you want as your default signature and 

click Default On/Off. The signature you selected will automatically be inserted into the e-mail 
message box on all subsequent e-mails you write.

For more information, see:
About E-Mail 
Adding a Signature to Your E-Mail 
Setting Up Signatures in E-Mail 
Turning Off the Default Signature 



Turning Off the Default Mail Signature
1 On the Mail menu on the AOL toolbar, click Mail Signatures.
2 In the Set up Signatures window, select the default signature (it is identified with a check mark)

and click Default On/Off.

For more information, see:
About E-Mail 
Adding a Signature to Your E-Mail 
Setting Up Signatures in E-Mail 



Checking Your Spelling
1 Type your message as usual.
2 Click Spell Check in the Write E-Mail form to check your spelling.
3 In the spell-checking window, click the misspelled word, type in your corrections (or select one 

of the words from the Suggestions list), and click Replace.

Notes
· You can also go to the Edit menu above the AOL toolbar, and click Spell Check. The AOL 

software will check your message. If an error is found, the spell-checking window appears, 
explains the error, and suggests corrections for it.

· You can set up a preference to check the spelling in your e-mail automatically.
· You can customize the spelling checker to notify you only of certain types of errors.

For more information, see:
About E-Mail 
Turning On the Automatic Spelling Checker 
Spelling Settings 
Personal Dictionary 



Turning On the Automatic Spelling Checker
1 On the Mail menu on the AOL toolbar, click Mail Settings.
2 Click the General tab.
3 Select the Perform a spell check before sending mail check box in the Mail Settings window.

Note
If you want to send e-mail without checking the spelling, hold the CTRL key down when you 
click Send Now.

For more information, see:
About E-Mail 
Checking Your Spelling 
About E-Mail Preferences 



Recovering Recently Deleted Mail
1 Sign on to the America Online service.
2 On the Mail menu on the AOL toolbar, click Recently Deleted Mail.
3 In the Recently Deleted Mail window, select the piece of mail you want to retrieve.
4 Click Restore. The e-mail will move to the New Mail tab in your online mailbox.

Notes
· E-Mail can be recovered only for 24 hours after you delete it.
· To permanently delete a piece of mail, click Permanently Delete. (You will never be able to

retrieve this mail again.)

For more information, see:
About E-Mail 



Using Your Address Book to Send E-Mail
1 On the Mail menu on the AOL toolbar, click Address Book.
2 In the Address Book window, select the contact to whom you want to send e-mail. (If you want 

to send e-mail to more than one person, hold down the CTRL key as you select additional 
contacts.)

3 Click Send, and then do one of the following:
4 Choose Send To to open the Write Mail window and copy the selected name(s) to the Send To: 

box. For contacts with more than one e-mail address, the screen name or e-mail address you 
have designated the "primary e-mail" address is used.

5 Choose Copy To to open the Write Mail window and copy the selected name(s) to the Copy To: 
box, so you can CC: the selected names.

6 Choose Blind Copy to open the Write Mail window and copy the selected name(s) to the Copy 
To: box, where they are listed in parentheses. When a recipient reads the message, the names of 
any recipients who were listed in parentheses won’t appear in the Copy To box.

Notes
· Hold down the Shift key and click two non-adjacent contacts to select all contacts in 

between.
· Hold down the CTRL key and click non-adjacent contacts to select them. 
· Remove a selected contact from the selection, hold down the CTRL key and click a selected

contact. 
· To send mail to a group, select the group under the Groups column, choose Group Options, 

and then choose Send Mail.

For more information, see:
About E-Mail 
About the Address Book 
Adding/Editing Contact Information in ihe Address Book 
Creating/Editing a Mailing List Group 



Adding an Address from E-Mail You Receive
1 Double-click the e-mail containing the e-mail address(es) you want to add. The e-mail will open 

in a new window.
2 Highlight (select) the e-mail address(es) you want to add to your Address Book.
3 Click Add Address.

Notes
· You can also add a person to your Address Book by right-clicking his or her e-mail address, 

then selecting Add to Address Book.
· If you don’t select an address before clicking Add Address, the address of the person who 

sent you the e-mail will be added to your Address Book.
· If you select more than one address, each address will be added as a separate entry. To create

a group listing, select the names you want added together as a group, and hold the CTRL 
key down as you click Add Address.

For more information, see:
About the Address Book 
Creating/Editing a Group Mailing List 
Using Your Address Book to Send E-Mail 



Creating/Editing a Mailing List Group
1 In the Mail menu on the AOL toolbar, click Address Book.
2 In the Address Book window, do one of the following:

· to display the current list of groups, click the + symbol next to Groups 

· to display the current list of groups you’ve shared at Groups@AOL, click the + symbol next
to Shared Groups

· to create a new group list, click Group Options and then choose Add Group 

· to modify the information for an existing group, click an existing group once to select it, 
click Group Options and then choose Edit Group

3 In the Manage Group window, type (or edit) the name of the group in section 1.
4 In section 2, select contacts to add to the group from the Contact List on the left (a list of all 

names in your Address Book) and click Add, or select contacts to remove from the group list on
the right and click Remove.

5 In section 3, type additional e-mail addresses (that are not already in your Address Book) to add 
to the group. Type a comma after each e-mail address you want to add.

6 In section 4, click Yes or No, to share the group (at Groups@AOL).
7 Click Save.

For more information, see:
About the Address Book 
Adding/Editing Contact Information in the Address Book 
Using Your Address Book to Send E-Mail 
 



Looking Up Contact Information
1 On the Mail menu on the AOL toolbar, click Address Book.
2 Position the cursor in the Quick Find: box, and begin typing the first few letters of the contact’s

first name, last name, or screen name. As you type, the contact list displays matching entries.
3 Select a contact to display detailed information about that contact in the right panel.

 Notes
· If you can’t find the contact you’re looking for, make sure that All Contacts is selected 

under Groups. Selecting All Contacts allows you to search all contacts in your Address 
Book.

· To change the information you are sharing with a contact, see Reviewing the Contact 
Information You're Sharing.

For more information, see:
About the Address Book 
Adding an Address from E-Mail You Receive 
Using Your Address Book to Send E-Mail 
Reviewing the Contact Information You're Sharing 
About Address Cards 
 



Printing All Address Book Information 
1 On the Mail menu on the AOL toolbar, click Address Book.
2 In the Address Book window, click Print.
3 In the Print window, select All contacts, choose a print output format, and then click OK.

Notes
· Choosing Complete will print all information you have stored in your Address Book for 

each contact.
· Choosing Summary will print key information for each contact.
· Choosing Mailing Labels will print mailing address labels for each of your contacts using 

the address you have designated as primary. You must use Avery® 5160™ or compatible 
labels in your printer for this feature to work.

For more information, see:
About the Address Book 
Printing Information For A Single Contact 
Printing Information For Multiple Contacts 
Using Your Address Book To Send E-Mail 



Printing Information for a Single Contact
1 From the Mail menu on the AOL toolbar, click Address Book.
2 In the Address Book window, select the contact whose information you want to print.
3 Click Print.
4 In the Print window, choose Selected contacts, choose a print output format, and then click 

OK.

Notes
· Choosing Complete will print all information you have stored in your Address Book for the 

selected contact.
· Choosing Summary will print key information for the selected contact.
· Choosing Mailing Labels will print a mailing address label for the selected contact using the

address you have designated as primary. You must use Avery® 5160™ or compatible labels 
in your printer for this feature to work.

For more information, see:
About the Address Book 
Printing Information for Multiple Contacts 
Printing All Address Book Information 



Printing Information for Multiple Contacts
1 From the Mail menu on the AOL toolbar, click Address Book.
2 In the Address Book window, hold down the CTRL key and select the contacts whose 

information you want to print.
3 Click Print.
4 In the Print window, choose Selected contacts, select a print output format, and then click OK.

Notes
· Hold down the SHIFT key and click two non-adjacent contacts to select all contacts in 

between.
· Hold down the CTRL key and click a selected contact to remove it from the selection.
· Choosing Complete will print all information you have stored in your Address Book for 

each contact.
· Choosing Summary will print key information for each contact.
· Choosing Mailing Labels will print mailing address labels for each of your contacts using 

the address you have designated as primary. You must use Avery® 5160™ or compatible 
labels in your printer for this feature to work

.
For more information see:
About the Address Book 
Printing All Information in the Address Book 
Printing Information for a Single Contact in Your Address Book 
Using Your Address Book to Send E-Mail 
 



Displaying Addresses by Category
When you assign a contact to a category in your Address Book you can quickly locate a specific 
contact by limiting the list of displayed contacts to those that match your chosen category.
This feature is especially handy to identify contacts that have been automatically added to your 
Address Book because you sent or forwarded mail to them.

To assign a contact to a category
1 From the Mail menu on the AOL toolbar, click Address Book.
2 Select a contact and click Edit. If the contact's Address Card appears, click Edit again to edit it.
3 Choose a category and click Save.

To display contacts by category
1 From the Mail menu on the AOL toolbar, click Address Book.
2 Under the Groups column, click the + sign next to Categories to expand the list of categories.
3 Select a category to display all contacts in that category.

Note
You can also drag a contact from the contact list and drop it into a category to assign it to that 
category. 



Retrieving a Map for a Stored Address
When you have stored home or work address information for a person, you can retrieve a map of that 
specific location directly from your Address Book. You must be signed on to use this feature.
To retrieve a map for a stored address

· Open your Address Book.
· Select the person whose address you wish to map.
· Under the person’s contact information, scroll down if necessary and click the Map It! with 

MapQuest® link. 

MapQuest is a registered trademark of MapQuest.com, Inc.



About the Address Book
The multipurpose AOL® Address Book makes it easy to keep track of e-mail addresses, phone 
numbers (home, work, cellular, fax, pager), mailing addresses (work and home), birthdays, 
anniversaries, and even the home pages of all your friends! You can add e-mail addresses to your 
Address Book directly from the e-mail you receive, and you can create group mailing lists for your 
private use, or to share with everyone on the mailing list at Groups@AOL. 
By using Address Cards, you can share your contact information with everyone in your Address Book 
and automatically keep your Address Book up-to-date with the latest contact information for everyone 
in your Address Book.
You can also synchronize your Address Book with a variety of handheld devices.
You can use your Address Book when you are offline, signed on, and even when you sign on to AOL 
using your friend's computer.

For more information, see:
Using Your Address Book to Send E-Mail 



About Address Cards
Your Address Card stores all your contact information in one convenient place. By sharing your 
Address Card with family, friends, and colleagues, you can be sure that they’ll always have your latest 
contact information. Sharing Address Cards also saves you time by automatically keeping your 
Address Book up-to-date with the latest contact information for everyone in your Address Book.
Address Card respects your privacy by letting you control the information you share and with whom 
you share it. Address Card works with Parental Controls by preventing kids from subscribing to 
Address Cards. Address Card also works with Mail Controls, by blocking Address Card sharing 
invitation e-mails from anyone who is on your Mail Controls Block list.
Most Address Card features are only available when you’re signed on. Click the Help button from any 
Address Card screen for more information.

To set up your Address Card or to choose how you want to share your Address Card
1 Sign on to the AOL service.
2 Go to AOL Keyword: Address Card.

For more information, see:
Adding Internet Address Cards To Your Address Book 



Adding/Editing Contact Information in the Address Book
1 From the Mail menu on the AOL toolbar, click Address Book.
2 In the Address Book window, do one of the following:
3 Click Add to add a new contact.

· To edit an existing contact or contact’s Address Card, click the contact once to select it, then
click Edit. If the contact’s Address Card appears, click Edit again to edit it.

4 Type (or edit) the information under the Contact, Home, Work, and Details tabs.
5 When you have finished, click Save.

Notes
· For Nickname, type the shortcut you want to use when entering this person’s e-mail address.
· For Home Page, type the contact’s web address or URL (e.g., http://www.aol.com ).
· Changes you make to a contact’s Address Card may be overwritten if the contact changes 

any of the information that you have edited. If you’ve canceled updates to someone’s 
Address Card, changes you make to their Address Card are not overwritten.

· Use the Category list to assign this contact to a category. If you store many contacts in your 
Address Book, the category feature helps you quickly sort your entries by allowing you to 
display only the entries assigned to a specific category, such as Friends or Family.

For more information, see:
About the Address Book 
Creating/Editing a Mailing List Group 
Using Your Address Book to Send E-Mail 



Adding Internet Address Cards to Your Address Book
When a non-member shares their contact information with you, you receive an e-mail message with an 
Internet Address Card attached to the message. If you’ve saved this message in your Saved On My PC
mailbox folder, you can add their contact information to your Address Book while you’re offline. (You 
can also add their contact information to your Address Book when you are signed on.)

To add someone’s Internet Address Card to your Address Book when you are not signed on
1 Click the Read icon on the AOL toolbar.
2 Select the Saved On My PC mailbox folder.
3 Double-click an e-mail to read it.
4 Click the link labeled Internet Address Card attached in the message. If the attachment only 

contains one Address Card, it is automatically added to your Address Book. If the attachment 
contains multiple Address Cards, a screen appears that lists all the contacts so you can choose 
the ones you want to add to your Address Book.

5 To decline a contact’s Address Card, select the contact from the list and click Remove.
6 Click OK to add the chosen contacts to your Address Book.

Notes
· If you don’t want to accept someone’s Internet Address Card, close the message or delete it.
· When you share your Address Card with non-members, your contact information is sent in 

vCard format, so it can be shared by different e-mail programs. AOL refers to vCards as 
Internet Address Cards. The vCard (.vcf) format is the standard method (like an electronic 
"business card") AOL uses to share contact information between AOL members and non-
members. 

· You can also import vCards (.vcf files) located on your computer by opening the File menu 
and choosing Open.

For more information, see:
About Address Cards 



Reviewing the Contact Information You're Sharing
To review or edit the contact information you’re sharing with the contacts in your Address 
Book
1 From the Mail menu on the AOL toolbar, click Address Book.
2 In the Address Book window, do one of the following:
3 Click Manage Address Card to display all contacts in your Address Book and the information 

you are sharing with them (All, Personal, Work, Primary E-Mail, or None). 
4 Click Subscribers Only to display only those contacts who have accepted your Address Card.
5 To change the information you are sharing with a contact, click Edit.
6 For each contact, choose the information you want to share with them.
7 When you have finished, click Save.

Note
When you select Manage Address Card or Subscribers Only, your Address Card is displayed to 
the right of the contact list.

For more information, see:
About Address Cards 



Syncing Your Address Book
Intellisync for AOL lets you to synchronize your AOL Address Book, allowing you to keep a single 
contact list "in sync" for all of your communications. With Intellisync for AOL you will never be 
without an e-mail address or phone number again. 
Intellisync for AOL works with Palm OS® handheld and Pocket PC handheld devices, as well as with 
Microsoft® Outlook® and Palm™ Desktop Windows® applications.  
You must be signed on to the AOL service to sync your Address Book.
After you have signed on, open your Address Book, choose Address Book Options, and then choose 
Sync to sync your AOL Address Book. If you have not yet downloaded the Intellisync program, the 
download page automatically appears and guides you through the download process. 
After you download the sync program, all you need to do is choose Sync anytime you want to 
synchronize contact information between your AOL Address Book and other devices and programs. 
For more information, visit AOL Keyword: AOL Sync. 



Using E-Mail Stationery
Spice up e-mail with a variety of e-mail stationery.
To add stationery to an e-mail message

1 Click Write on the AOL toolbar.
2 In Send To, type the e-mail address of the person you want to send e-mail to. (To send the same 

message to another person, type a comma and add the next e-mail address.)
3 In Subject, type a brief description or title for your message.

4 On the style toolbar above the large message box, click the Extras button . 
5 Choose stationery from the list of available options. The background of your message will be 

updated to show the stationery you have chosen.

You can automatically have specific stationery added to every message you write.
1 Click the Extras button, and then click Manage Extras.
2 Click the stationery you wish to add to your mail messages once to select it, and then click 

Default On/Off. A red check mark appears next to the stationery name to indicate it will be 
added to all messages you write by default.

3 Click the  to close the Manage Extras window.

Notes
· You must be signed-on to AOL to use the Manage Extras menu option.
· When you are signed on, you can choose from a variety of stationery and postcard 

templates, and add them to your list under Extras.
· You can add or change stationery at any point before you send your message.
· To add or remove stationery choices from your list of options, click the stationery button, 

and then click Manage Extras.



What do the different mail icons in my mailbox signify? 
The mail icons in your mailbox are designed to help you quickly distinguish whether the mail is from 
someone you know and whether it has an attached file or picture embedded in it.
Mail Type Description Icon
Mail from people you know  

 – with attachment  

 – with embedded image  

 – with attachment & embedded 
image

 

 – Official AOL® Mail  

 – voice mail
Bulk Mail
 – with attachment
 – with embedded image
 – with attachment & embedded 
image
Mail from unknown senders
 – with attachment
 – with embedded image
 – with attachment & embedded 
image
Spam Mail  

Priority Mail  

Featured Mail  

Sent Mail  

Note
Spam Mail, Priority Mail, Featured Mail, and Sent Mail that have embedded images or 
attachments may look slightly different. Mail with embedded images has a small square in the 
mail icon. Mail with attachments has a small disk image in the mail icon.



Why are some messages in my mailbox listed in bold type and 
others are not?
The AOL service makes it easy for you to distinguish between messages that you have read before and 
kept as new in your mailbox, and messages that you have yet to read.
Mail that you have read before, including mail read in the preview pane, will be listed in normal type.
Mail that you have yet to read will be listed in bold.

Note
If new mail arrives while your mailbox is open, the mail will be listed in bold and an asterisk 
will appear next to the date.



Setting Up Your Mailbox Folders
You can create, rename, delete, and move mailbox folders.

1 Click the Read button on the AOL toolbar.
2 Click the View All tab.
3 Click a mailbox folder or subfolder. If you aren’t signed on to AOL, you can only view the 

subfolders within the Saved on My PC mailbox folder. 
4 Click the Setup Folders button and click one of the following options:

· Create Folder: Create a new subfolder within the selected folder.
· Rename Folder: Rename the selected folder.
· Delete Folder: Delete the selected folder.
· Move Folder to…: Move the selected folder to a new location in your mailbox. Click New 

Folder to move the folder within a new folder. 

Notes
· You can only rename, delete, or move mailbox folders that you have created.
· To move a folder, you can also use the mouse to drag and drop the folder to a new location.

For more information, see:
About E-Mail 



Searching E-Mail
To quickly search for e-mail within a selected mailbox folder:

1 Click the Read button on the AOL toolbar.
2 Click a mailbox folder or subfolder. If you aren’t signed on to AOL, you can only view the 

subfolders within the Saved on My PC mailbox folder. 
3 Click the field labeled Quick Find.
4 Type an e-mail address or subject. As you type, the e-mail list will show e-mails that match 

either the e-mail address or subject you type.

To search all e-mails in your mailbox:
1 Click the Read button on the AOL toolbar.
2 Click the Search Mail tab.
3 Click the Search drop-down menu and click on one of the following options:

· E-Mail Address & Subject: Search e-mail addresses and subjects of e-mails.
· E-Mail Address only: Search only e-mail addresses of e-mails.
· Subject only: Search only subjects of e-mails.

4 Click the field labeled for:.
· Type in a search term.

5 Press Enter or click Search. The e-mail list will show e-mails that match your search term.

Note
If you aren’t signed-on, you can only search e-mail that is in the Save On My PC mailbox 
folder.

For more information, see:
About E-Mail 



Printing E-Mail
You can print e-mail to read away from your computer.

1 Open an e-mail message in a separate window.
2 Click Print. 
3 Choose print options such as printer selection, page range, and number of copies.
4 Click Print in the Print window.

For more information, see:
Using Print Setup 
Using Print Preview 



How do I use the Quick Read panel?
If you have your resolution set to 800 x 600 or higher, the Quick Read panel is available. When open, 
the Quick Read panel shows messages you double-click. You don't have to open and close separate 
windows to read each of your messages.
To open the Quick Read panel

1 Click Read on the AOL toolbar.
2 If the Quick Read panel is closed, click the Show Quick Read Panel button which is located on

right edge of the Mailbox window and looks like a small arrow pointing to the right.

To hide the Quick Read panel
1 Click Read on the AOL toolbar.
2 If the Quick Read panel is open, click the Hide Quick Read Panel button, which is located on 

right edge of the Mailbox window and looks like a small arrow pointing to the left.

To open messages in the Quick Read panel
1 With the Quick Read panel open, double-click a message in the message list. The message will 

be displayed in the Quick Read panel.

Note
If you want to see mail headers in the Quick Read panel, click on the Show complete mail 
header button, which is located at the top of the Quick Read panel and looks like a small arrow 
pointing down.



Storing Passwords for Automatic AOL
1 On the Mail menu on the AOL toolbar, click Set Up Automatic AOL.
2 Click Select Names.
3 Select the screen name you want Automatic AOL to use.
4 Type your AOL password for the screen name you selected.

Notes
· If you are online when you activate Automatic AOL, it will run for the screen name you are 

signed on with.
· Choosing to perform an Automatic AOL session for more than one screen name may result 

in the AOL software failing to perform properly. 

For more information, see:
About Automatic AOL 



About the Mailer-Daemon
If you receive e-mail from mailer-daemon, there was a problem with a piece of e-mail you sent 
recently to an Internet address.
An example of an Internet address is:
user_name@domain.name.com
Some common mailer-daemon errors:
Unknown Host      Check the site.domain section for possible spelling errors. It is also possible that the
computers located at that Internet address are temporarily unavailable.
Unknown User    Check the user_name section for possible spelling errors.
Service Unavailable    Try sending your e-mail again later; the receiving site is down temporarily.
Unbalanced    Check the address for extraneous quotation marks or parentheses.
Cannot Send for XX Days    Try sending your e-mail again in a day or two.
Unrecoverable Error    The message left AOL properly, but critical errors occurred within the 
receiving system.

For more information, see:
About E-Mail 



Member's Mailbox is Full
The AOL service sets generous limits on the number of messages that can be maintained by any 
account. However, some members do manage to reach the limit, especially if they keep all mail as new,
receive a lot of mail, or subscribe to mailing lists. You will not be able to send e-mail to the person 
until he or she clears out some mail.

For more information, see:
About E-Mail 



Common Errors Sending E-Mail to the Internet
A typical Internet e-mail address follows this basic format:
name@site.domain
 
Most addressing errors fall into these categories:
Typographical errors    Check the e-mail address carefully to make sure you are typing it exactly as it 
was given to you.
Capitalization    Some Internet addresses are case-sensitive. Try typing the address using all lower 
case letters.
Extra spaces    Internet addresses contain no spaces. Some addresses may contain an underscore to 
separate two words, for example: firstname_lastname@site.domain
Unnecessary designations    The AOL® service does not require any special characters to designate an
e-mail address. Simply use the full e-mail address, such as name@site.domain,
Typing Web addresses instead of e-mail addresses    If you type a Web address (starting with "www."
or "http://") instead of an e-mail address, you may get the following error: "HTTP is not a known 
member." 

For more information, see:
About E-Mail 



Member is not Accepting E-Mail
AOL's Mail Controls™ feature allows members to determine from whom they accept e-mail.
If a member has set Mail Controls that block you from sending him or her e-mail, you will not be able 
to use e-mail to make contact.

For more information, see:
About E-Mail 



This is not a Known Member
You are trying to send mail to a screen name that doesn't exist: either the account has been closed, or 
you have misspelled the screen name. Close the error message window and double check the spelling 
of the recipient's screen name.

For more information, see:
About E-Mail 
 



Saving Copies of Your E-Mail
You can save copies of your e-mail in two ways:
Save Your E-Mail to Your Computer Or Disk 
Automatically Save Your E-Mail to Your Computer 

Note
E-Mail you save in your Saved on My PC mailbox folder will remain on your computer until 
you delete it.

For more information, see:
About Settings and Preferences 



Setting Automatic AOL Preferences
1 On the Mail menu on the AOL toolbar, click Set Up Automatic AOL.
2 Select the tasks you want Automatic AOL to perform (for example: Send mail . . . or Get unread 

mail . . .).
3 Click Select Names.
4 Select the screen names for which you wish the tasks you have selected to be performed. 
5 For each selected screen name type your AOL password.

Notes
· Anyone who has physical access to your computer can sign on to your account if you store 

your password.
· If you decide not to store your passwords, you can sign on to America Online with each 

screen name and start Automatic AOL manually while you are online.

For more information, see:
About Automatic AOL 
About Communications Preferences 
Storing Passwords For Automatic AOL 



Understanding Internet Addresses
An e-mail header is a history of the route a particular piece of e-mail has "traveled" from the time it 
was created until the time it was delivered to your e-mail inbox on the America Online service. You can
think of an e-mail header like the stamps in a passport -- each stamp shows a country that was visited 
or passed through during a trip. 
While e-mail header information can be used to trace the origin of a piece of e-mail, persons who send 
unsolicited bulk e-mail routinely manipulate this routing information to make it appear that the e-mail 
originated from someplace other than it actually did. In fact, some persons attempt to make it look as 
though the mail was sent by America Online itself. AOL makes it easy for you to identify mail that 
originated from outside the America Online service by replacing the mail headers with a simple link 
that reads "Sent from the Internet (Details)." If you wish to see the complete header information, just 
click Details.

Notes
· You should generally not respond to unsolicited bulk e-mail (also known as junk mail), even

when the text of the mail has instructions to unsubscribe. Our experience shows that 
responding to a piece of junk e-mail merely confirms that your e-mail address is legitimate 
and can often result in even more junk e-mail being sent to you.

· You can report unsolicited bulk e-mail received from the Internet by clicking Report Spam 
on the AOL mailbox. 

· AOL Mail Controls allow you to block e-mail from Internet domains (the information that is
found after the "@" sign in an Internet e-mail address) and e-mail addresses that you 
specify. For more information, sign on and go to AOL Keyword: Mail Controls.



Saving E-Mail and Pictures to Your PC Automatically
By default, AOL mail you have read or sent is stored to your computer automatically. Mail is stored in 
the Saved on My PC folder of your mailbox and can be read even when you aren’t signed-on to AOL. 
You can change your mail settings so that pictures that are embedded in e-mail you read or send can be 
automatically saved to the My Pictures folder on your computer (a sub-folder of the My Documents 
folder).

To change your mail settings for automatic e-mail and picture storage, do the following:
1 On the Mail menu on the AOL toolbar, click Mail Settings.
2 Select or unselect these checkboxes:

· Retain all mail I read in my Saved Mail folder
· Retain all mail I send in my Mail I’ve Sent folder

3 Click the Advanced tab, and select the following checkbox:
· Retain all embedded images in read mail

Notes
· Mail settings that control automatic e-mail storage also control picture storage.
· To open mail saved on your PC, open the Mail menu on the AOL toolbar and click Saved 

on My PC. Click the Incoming/Saved Mail subfolder to read mail that you have previously
read.

For more information, see:
About E-Mail 



Sorting the E-Mail Items in Your Mailbox
1 Click the Read icon on your AOL® toolbar.
2 Click one of the column headings (i.e., Type, Date, E-Mail Address, and Subject) to sort your e-

mail. The arrow will indicate whether items are being sorted in ascending or descending order.

 

Notes
· You can filter the list of mail in your mailbox by type using the Show me Mail from menu.
· When you are signed-off of AOL, you can only sort e-mail in your Saved on My PC 

mailbox folder.

For more information, see:
About Offline Message Boards & Newsgroups 
Searching Message Boards & Newsgroups 



About Automatic AOL
You can use the Automatic AOL function to perform tasks for your account automatically. You can:

· send and retrieve e-mail.
· send and retrieve newsgroup or message board postings.
· download files you have collected in your Download Manager.

You can run Automatic AOL on demand, or set up a schedule and have the tasks performed at certain 
times of the day whether you're at your computer or not.

Notes
· Each screen name has its own incoming mailbox, outgoing mailbox, and Download 

Manager
· You cannot use Automatic AOL if you are signed on as a guest.



Activating Automatic AOL
1 From the Mail menu on the AOL toolbar, click Set Up Automatic AOL.
2 Click Run Automatic AOL Now.

Note
If you are online when you activate Automatic AOL, it will run for the screen name you are 
signed on with.

For more information, see:
About Automatic AOL 
Scheduling Automatic AOL 
Turning Off Automatic AOL 



Scheduling Automatic AOL
1 On the Mail menu on the AOL toolbar, click Set Up Automatic AOL.
2 Click Select Names to choose a screen name for which to run Automatic AOL.
3 Select the tasks that you want Automatic AOL to perform. These include:

· Send mail from the "Mail Waiting to be Sent" folder.
· Get unread mail and put it in "Incoming Mail" folder.
· Download files that are attached to unread mail.
· Send postings from the "Postings Waiting to be Sent" folder.
· Get unread postings and put in "Incoming Postings" folder.
· Download files marked to be downloaded later.

4 Click Schedule Automatic AOL.
5 Select the Enable Scheduler check box, and select the days and times you want Automatic 

AOL to run, and then click OK.
6 Make sure the America Online application is open (not signed on) at the scheduled time.

For more information, see:
About Automatic AOL 
Activating Automatic AOL 
Turning Off Automatic AOL 



Setting Up Automatic AOL to Send/Retrieve E-Mail
1 On the Mail menu on the AOL toolbar, click Set Up Automatic AOL.
2 Select the checkbox labeled: Send mail from the "Mail Waiting to be Sent" folder.
3 Select the check box labeled: Get unread mail and put it in "Incoming Mail" folder.
4 Click Select Names and select a screen name and type your AOL password, then click OK.
5 Click the X in the upper right corner of the Automatic AOL screen to close it.

Notes
· Anyone who has physical access to your computer can sign on to your account if you store 

your password.
· If you decide not to store your passwords, you can sign on to America Online with each 

screen name and start Automatic AOL manually while you are online.

For more information, see:
About Automatic AOL 
Storing Passwords For Automatic AOL 
About E-Mail 



Turning Off Automatic AOL
1 On the Mail menu on the AOL toolbar, click Set Up Automatic AOL.
2 Click Schedule Automatic AOL.
3 Clear the Enable Scheduler check box.
4 Click OK.

For more information, see:
About Automatic AOL 
Activating Automatic AOL 
Scheduling Automatic AOL 



Setting Up Automatic AOL to Download Files
1 On the Mail menu on the AOL toolbar, click Set Up Automatic AOL.
2 Select the check box labeled: Download files marked to be downloaded later.
3 Click Select Names and select a screen name and type your AOL password, then click OK.
4 Click Run Automatic AOL Now.

Note
If you are online when you activate Automatic AOL, it will run for the screen name you are 
signed on with.

For more information, see:
About Automatic AOL 
About Downloading 



Using Automatic AOL to Read Message Boards and Newsgroups 
When You Are Not Signed On
Overview
(For detailed instructions on any step, click the link.)
Select message boards for Automatic AOL to retrieve 
Selecting Newsgroups to Read When You Are Not Signed On 
Setting Up Automatic AOL to Send/Retrieve E-Mail 
Activating Automatic AOL 
Reading and Responding to Newsgroup Postings When You Aren't Signed On 

For more information, see:
About Automatic AOL 



Managing Offline E-Mail
You can manage your e-mail Personal Storage areas to recover information in the event you experience
a problem. There are three options available to use to manage saved e-mail in your Personal Storage 
areas:    Backup, Restore, and Compact.
To use saved mail management options

1 From the Settings icon on the AOL Toolbar, click Mail Settings. The Mail Settings window 
opens.

2 Click Manage Saved Mail. A drop-down menu opens with the following options:
· Backup
· Restore
· Compact

For more information, see:
Mail Settings 
Backup Your Personal Storage 
Restoring Your Personal Storage 
Compacting Personal Storage Space 



Backup Your Personal Storage
Backing up e-mail saved in your Personal Storage lets you safeguard the information you have stored 
there. Once you’ve backed up your Personal Storage, it is easy to restore lost information in the event 
you experience a problem
You can back up your e-mail manually or you can set a preference to do it automatically at a desired 
interval.
In the event you experience problems with your Personal Storage area and lose its contents, it is easy to
restore information that you previously backed up.
To manually backup your Personal Storage

1 From the Settings icon on the AOL Toolbar, click Mail Settings. The Mail Settings window 
opens.

2 Click Manage Saved Mail. 
3 Click Backup. The Backup Your Personal Storage window opens. 
4 Click Backup Now. 

Note
You can set up automatic, scheduled backups in Mail Settings.

For more information, see:
Mail Settings 
Restoring Your Personal Storage 
Compacting Personal Storage Space 



Restoring Your Personal Storage
In the event you experience problems with your Personal Storage area and lose its contents, it is easy to
restore information that you previously backed up.
To restore your Personal Storage

1 From the Settings icon on the AOL Toolbar, click Mail Settings. The Mail Settings window 
opens.

2 Click Manage Saved Mail. 
3 Click Restore. The Restore Your Personal Storage window opens. 
4 Click Yes in response to the question Are you sure you want to restore your Personal Storage to 

restore the information previously backed up.

Notes
· You can only use the Restore command if you have previously backed up the contents of 

Personal Storage.
· When you use the Restore command, you replace the current contents of Personal Storage 

with your backup copy.

For more information, see:
Mail Settings 
Backup Your Personal Storage 
Compacting Personal Storage Space 



Compacting Personal Storage Space
When you delete items from your Personal Storage area, the empty space on your computer is not 
reclaimed and available for use until you run this utility.
To compact your Personal Storage

1 From the Settings icon on the AOL Toolbar, click Mail Settings. The Mail Settings window 
opens.

2 Click Manage Saved Mail. 
3 Click Compact. A Performance Warning window opens. 
4 Click Compact Now in response to the question What would you like to do to compact the 

space in your Personal Storage area, making it available for your computer’s use.
5 Once the compact utility finishes, you’ll see an America Online window open, stating {your 

screenname’s} Personal Storage is fully compacted. Click OK to close the window.

For more information, see:
Mail Settings 
Backup Your Personal Storage 
Restoring Your Personal Storage 



About Master Screen Names
The primary Master Screen Name — the first screen name you created when you first registered as an 
AOL member — cannot be removed as a Master Screen Name. Master Screen Name status can be 
assigned to a maximum of 2 additional existing or newly created screen names besides the primary 
Master Screen Name. To assign Master Screen Name status to a screen name, you must first assign it 
an 18+ rating through the Parental Controls feature.
A member logged in with a Master Screen Name can:

· change the account's billing method and price plan.
· change the Parental Controls settings for other screen names on the account.
· create, delete, or restore screen names on the account.

For more information, see:
About Screen Names 
Designating Additional Master Screen Names 
About Your Password 



About Screen Names
Each AOL account can have up to seven screen names at any one time. The screen name you chose 
when you set up your AOL account is your Master screen name; it cannot be deleted or changed.
Keep in mind the following:

· Your screen name is your AOL e-mail address.
· Your screen name can be seen in public places, such as chat rooms, message boards, AOL 

Hometown, and the AOL Member Directory (if you have created a Member Profile). If you 
want, you can take steps to help to protect your privacy while online.

To learn more about screen names:
1 Sign on to the America Online service.
2 Go to AOL Keyword: Help.

Notes
· The Master Screen Name (the first screen name you selected when you registered your AOL

account) cannot be deleted or changed.
· Your account can have up to seven screen names, each with separate passwords, mailboxes, 

filing cabinets, and Favorite Places.

For more information, see:
About Master Screen Names 
Designating Additional Master Screen Names 



Designating Additional Master Screen Names
1 Sign on to the America Online service with the Primary Master Screen Name.
2 Click Safety on the AOL toolbar.
3 Click Parental Controls.
4 Click the screen name that you want to change.
5 Click the More Options button and select Additional Master.
6 Carefully read the information about master screen name designation, then select the Designate 

this screen name a master screen name check box.
7 Click Save.

Note
You can select up to two screen name(s) to designate as additional Master Screen Names.

For more information, see:
About Master Screen Names 
About Screen Names 



If Your Screen Name is not Visible on the Sign On Screen
1 On the Sign On screen, select Existing Member from the Select Screen Name list.
2 Click Sign On.
3 Enter a screen name from your account and the password for that screen name when prompted. 

The next time you sign on, all of your screen names will appear on the Sign On screen.

Why did this happen?
If you reinstalled the software on your current computer or installed software for the first time on a 
new computer, your screen names will not be available on the Sign On screen until you sign on for the 
first time using that software.

What if someone else’s screen names are in the list?
If you share your computer with another AOL member, the shortcut you clicked to start the AOL 
software probably does not point to your copy of the software. Call AOL Member Services at 1-800-
827-6364 for assistance with creating a new shortcut that will start your copy of the AOL software.

What if all my screen names are available except the one I am looking for?
Check with others who have access to master screen names on your account and confirm that the 
screen name you are looking for was not deleted or used to create a second AOL account. If neither of 
these scenarios has occurred, or if you need additional help, call AOL Member Services at 1-800-827-
6364.

For more information, see:
About_Screen_Names 



 Using the Menu Bar
The words across the top of your screen -- File, Edit, Mail, Community, Services, Safety, Window, 
Keyword, Sign On/Off and Help -- make up the AOL menu bar. The familiar menu bar format gives 
you access to common commands like Open, Exit, Save, Copy, and Paste as well as commands needed 
to get around on the AOL service.
Click a word in the menu bar to open a menu of related commands. Items that appear dimmed are not 
available, usually because you're not signed on to AOL, or because you are signed on using the Guest 
feature.
You can open any menu by typing ALT and the underlined letter in the menu name. For example, to 
open the Window menu, type ALT+W. When a menu is open, you can also use ALT and the underlined
letter to open any item that appears on the menu.

The File Menu
New – creates a new document.
Open – opens an existing document.
Open Picture Finder – opens thumbnail pictures in a browse format.
Open CD/Media Player – Will start the AOL Media Player.
Save – saves the document you're working on.
Save As – names and saves the document you're working on.
Print – opens the Print dialog window. From here you can print single or multiple copies of e-mails, 
text from Web sites, and other information.
Print Preview  – lets you see a page before you print it. 
Mail Saved on My PC (Filing Cabinet) – saves e-mail for as long as you specify.

Download Manager – opens the Download Manager.
Log Manager – opens the Log Manager.
Exit – closes the AOL software.

The Edit Menu
Provides familiar editing commands like Undo, Cut, Copy, Paste and Select All. It also allows you to 
Spell Check e-mail or other documents, and consult a Dictionary or Thesaurus.

The Mail Menu
Offers options for handling your mail, including saving messages on your PC, setting up a signature 
file, and blocking unwanted mail.

The Community Menu
Provides features related to communicating with friends and family online, such as Chat, the Buddy 
List® feature, the Instant MessagerTM feature, AOL Hometown, Groups@AOL, and much more. 
(This menu is available only while you are signed on to AOL.)

The Services Menu
Provides a range of resources, including, Calendar, AOL Auto Center, Homework Help, movie 
showtimes, and more. (Some of these features are available only while you are signed on to AOL.)

The Safety Menu
Provides access to a range of resources designed to help you have a more safe and more secure online 



experience. Resources include Parental Controls, Computer Checkup, spam and Web Pop-Up Controls,
and more. (This menu is available only while you are signed on to AOL.)

The Window Menu
Lets you arrange the windows and remember their sizes. It also keeps a list of how many AOL screens 
are currently open on your monitor.

The Keyword Menu
Provides access to AOL Keywords, which are shortcuts to online areas of the AOL service. (This menu 
is available only while you are signed on to AOL.)

The Sign Off Menu
Allows you to sign off the AOL service, or to Switch Screen Names without signing off and losing 
your connection. When you are not signed on, the title of this menu changes to Sign On and lets you 
display the Sign On screen if it has been closed.

The Help Menu
Lets you access the AOL Help area. You can use About America Online to check what version of the 
AOL software you are currently running.

For more information, see:
Using The AOL Toolbar 



Using the Find in Top Window Feature
1 Click anywhere in the AOL window you want to search to make it the active window.
2 On the Edit menu, click Find in Top Window.
3 Type the word or phrase you want to search for and click Find.



Creating Keyboard Shortcuts
1 On the Favorites menu on the AOL toolbar, point to My Hotkeys and then click Edit My 

Hotkeys.
2 In the Shortcut Title box, type a name for the shortcut.
3 In the Keyword/Internet Address box, type the Keyword or URL you want to associate with 

the shortcut and click Save Changes.

Note
To use the shortcut, press CTRL + n (where n is the Key listed on the right of the window).



Changing Windows Colors and Fonts
1 On the Windows taskbar, click Start, point to Settings, and then click Control Panel.
2 Double-click Display.
3 In the Display Properties window, click the Appearance tab.
4 Select a scheme for the list, or create your own custom scheme, and click OK.

Note
Some areas of AOL are not affected by the color scheme you have chosen within Windows.



More information about the Guest function
· The time you spend online is charged to your account.
· You cannot access your Saved on My PC mail folder when signed on as a Guest from 

another computer (because this information is stored on your own computer.)
· You cannot use Automatic AOL or Download Manager when you are signed on as a Guest. 



Accessibility at America Online
At AOL, we value our members and strive to provide them with the highest quality, easiest, and most 
convenient services and products.    We also believe that the Internet and the AOL service should be 
friendly and easy to use for all of our members.    In that spirit, AOL has developed the America Online 
Accessibility Policy which expresses our commitment to the development of products and services that
are accessible to all users, including those with disabilities.
You can find our policy at AOL Keyword: Accessibility, or at www.aol.com/accessibility.
Beginning with AOL version 7.0, we focused on ensuring that essential features such as connectivity, 
registration, e-mail, instant messaging, parental control/screen name administration, toolbar, and chat 
features were compatible with screen readers, screen magnifiers and other assistive technology 
products. Our goal is to build on this foundation with each subsequent release.
With later versions of AOL, we introduced mainstream features that can be leveraged to enhance 
usability by people with disabilities. Members who are blind or visually impaired are alerted to the 
arrival of new e-mail by an audio indicator that makes a clicking noise whenever a new e-mail appears 
in your mailbox. We also introduced custom instant message sounds that allow members to either 
create their own or choose from a list of customized sounds that are attached to their screen name. Now
every time that you receive an instant message you know who it's from because of the sound associated
with it.

For more information, see:
AOL Keyword: Accessibility 



Features For Deaf and Hearing Impaired Members
Members who are deaf or hearing impaired can benefit from a visual indicator that alerts AOL 
members to incoming instant messages. When a user receives an instant message from one of their 
buddies, the AOL icon on the bottom of the screen flashes. Another great visual feature for deaf and 
hearing impaired members is the AOL Companion. The AOL Companion sits on the bottom of your 
screen and pops up the contents of the latest IM you received. This feature means you will never miss 
an IM when you have multiple windows open or you are working in another program.
AOL is committed to offering captioning on streaming video throughout the AOL service.    We are 
currently working with partners to expand our captioning capabilities.    To enable captions, go to AOL 
Keyword: Preferences and click on multimedia. Then click on display captions.
We encourage you to sign on and go to AOL Keyword: Accessibility to learn more about these and 
other accessibility features.



AOL Keyword: Accessibility
The AOL Accessibility Help site provides a central location where members can find tips and hints 
about accessibility features designed into AOL products and services. AOL Keyword: Accessibility 
Help provides helpful information about compatibility with Assistive Technologies (AT) such as screen
readers, screen magnifiers, alternatives to the keyboard or mouse, and voice recognition. The site also 
informs visitors about new product developments such as wireless messaging and speech deployment 
that are making it easier for all consumers – and specifically people with disabilities - to use AOL and 
the Internet.



Keyboard Shortcuts
Toolbar Functions 
These shortcuts perform functions that are listed in the Toolbar. We have listed the most popular to help
you get started. 
Mail
CTRL + M = Write Mail
CTRL + R = Read New Mail
ALT + M = Opens the Mail Menu. This menu provides access to your address book, online mailbox, 
and other mail related features

Instant Messaging
CTRL + I = Send Instant Message 
CTRL + Enter = Performs the same action as selecting the Send button on the instant message form.
CTRL + 1 = Buddy List
CTRL + 2 = People Connection (Chat)
ALT + C = Opens the Community Menu. This menu provides access to chat and instant messaging 
related features.

General Windows Navigation
CTRL + Tab = Switch between open windows on the AOL service
ALT + W = Window Menu
ALT + W followed by A = Close All Windows Except Front
CTRL + K = Go to Keyword
CTRL + W = Navigates to the Toolbar where you can type web addresses or Keywords (similar to 
CTRL + K)
ALT + V = Opens the Favorites Menu. From here you can add areas of the service you commonly use 
to your Favorites list and access your Favorites.

Other Shortcuts
CTRL + P = Print
F1 = Help 
ALT + S = Opens the AOL Services Menu. This menu provides various services such as yellow pages, 
sports scores, and TV listings.
CTRL+K, type Settings, then press Enter = Opens the Settings window where you can change various 
AOL settings.



Tips for Connecting to the AOL® Service Using Your Screen Reader
For optimal screen reader support, we recommend use of JAWS 4.5.1 with the AOL service. We also 
recommend that you download and listen to "Using AOL with JAWS," a comprehensive demonstration
of key AOL features including the sign-on process, sending and receiving instant messages, interacting 
with the Buddy List® feature, reading and writing e-mail, browsing the web from within AOL, and 
interacting with staple AOL features like Parental Controls. The tutorials are available at 
www.aol.com/accessibility.
The following instructions assume that you have already registered for the AOL service. If you have 
not registered for the AOL service, you can do so by phone or online. Call 1-800-827-6364 to register 
by phone.

Sign on
Once you have installed the software and registered for the AOL service, the Sign-on screen will 
appear. This screen will appear whenever you start AOL. The sign-on screen requires you to provide a 
screen name and password before you can sign on to the AOL service. 
The following information about the boxes will help you get started. There are three key controls on 
the Sign on Screen -- Select Screen Name box, Enter Password edit field and Select Location box. 
The Enter Password edit field has focus when the Sign-on screen opens. Press Shift + Tab to review 
information in the Select Screen Name box. Press Tab to review information in the Select Location 
box. Press Enter to sign on. 
Select Screen Name box - This box is a drop-down menu. The default entry will be the screen name 
used when you last logged on. If the screen name that appears is not the one you want to use, press the 
Up or Down arrow key to review the list of available screen names. Press the Enter key to select the 
desired screen name. Select "Guest" if you are using someone else's computer. 
Enter Password edit field- Type in your password. The screen reader will display "star" rather than 
the actual letters you are typing to protect your privacy. To permanently store your password, visit AOL
Keyword: Preferences.
Select Location box – This is a pull-down menu. The default entry will likely be home. This box tells 
the computer which type of connection you want to use to log on to AOL – dial-up using a modem or 
some other type of connection including TCP/IP, cable modem, etc. AOL has local access numbers for 
hundreds of locations across the country. You can add new local access numbers at any time. Please be 
sure to select a local telephone number to ensure that you do not incur long distance telephone charges.

After sign on
After you sign on, a number of windows will open including promotional windows, the Welcome 
Screen, the Buddy List® window and AOL Channels.
Tip: To close promotional pop-ups, tab to the "no thanks" button which is located in the lower left 
corner of the window. To disable promotional pop-ups, go to AOL Keyword: Choice and change your 
marketing preferences.
Now you have completed the sign on process and can start using AOL! 

Reading and Sending E-Mail
Press Control+R to open your mailbox. The mailbox opens with focus in the list of messages waiting to
be read. Review your messages by pressing the Up or Down arrow keys on your keyboard. Press Tab 
and Shift + Tab to review additional mail controls.
Press Control+M to write an e-mail. When the "Write Mail" window opens, focus is in the "to" field 
where you can type the e-mail address of the recipient(s).



Press Tab and Shift + Tab to locate available controls. Press Control + Enter to send your message. For 
more information on e-mail visit, AOL Keyword: mail.

Using your Buddy List®    Feature
Press CTRL+1 to display your Buddy List window. Once opened, press the Up and Down arrow keys 
to locate a friend, family member or colleague. Press the Enter key to select a contact to whom you 
want to send an instant message. If your list is empty, press theTab key to navigate to the "Setup" 
button.    The Setup button is on the bottom right of the Buddy List box.
For more information on Buddy List visit AOL Keyword:    Buddy List.

Sending an Instant Message
Press Control+I to open the instant message window. Once opened, type the screen name of the friend, 
contact, family member or colleage with whom you want to communicate. Press the Tab key once, then
type your message. Press Control+Enter to send the message. For more information on instant 
message, visit AOL Keyword: Instant Messaging.

Visiting the Internet
Press Control+W to open the AOL toolbar. Once opened, type the web address of the site you want to 
visit. Press the Tab key to review additional controls available on the toolbar.



Getting Around the AOL Service
AOL’s number one priority is improving the service so members can navigate the AOL service 
effortlessly and use its features easily. 
When you sign on, the AOL service opens several windows. For the best results, open the AOL 
Windows Menu by pressing ALT + W. Navigate to the welcome screen and open it by pressing Enter. 
The Welcome screen is now your active window and your screen reader reads Welcome and your 
screen name. The AOL service activates multiple windows when you sign on, including the Buddy List
feature, AOL Channels and promotional windows; the windows that open may vary. As you become 
more familiar with the AOL service you will be able to determine which windows you would like 
opened upon sign on and which you prefer not to open. 

Note 
To ensure that your screen reader is locked in to the active window, click the Window menu at 
the top of your America Online screen and select Close All Except Front.

For more information, see:
Keyboard Shortcuts 



Using the AOL Toolbar
The row of colorful buttons near the top of your AOL screen is called the "toolbar." Within the toolbar 
are "icons." These give you a quick way to get to AOL's most popular features. Just click and go. For 
example, clicking the Write icon opens the Write Mail window.

 
Click Read to open your mailbox, where you can read new mail, old mail, and mail you've sent.
Click Write to display a blank e-mail form. Use this to create and send an e-mail message.

Click the IM icon to open a blank instant message form. (This feature is only available when you are 
signed on.)
Click the People icon to access People Connection, which includes links to chat rooms, AOL Live, 
Love@AOL, AOL Home Pages, and more. (This feature is only available when you are signed on.)
Click the Safety icon to get more information about helping to protect yourself and your family online.
(This feature is only available when you are signed on.)
Click the Settings icon to review and customize features of the AOL service such as your Member 
Profile, AOL Home Page, Self Expressions (Buddy Icon, Buddy Wallpaper, Buddy Sounds, and more), 
text and formatting features, as well as other AOL preferences.    
Click the Music icon to listen to today’s hottest hits. (This feature is only available when you are 
signed on.)
Click Finance to access AOL Personal Finance, which links you to a wealth of financial information, 
including stock prices, insurance information, and business news. (This feature is only available when 
you are signed on.)

Click the Favorites icon  to open your Favorite Places window. (This feature is only 
available when you are signed on.)

Customizable Toolbar Carousel Icons
In the area to the right of the Finance icon is the Toolbar Carousel, which holds up to 18 icons that you 
can use to customize your toolbar. To see all the icons in the Toolbar Carousel, click the right or left 
arrows to scroll through them. (This feature is only available when you are signed on.)

To customize the toolbar, click the Customize icon.

For more information, see:
Using The Menu Bar 
Toolbar Settings 



About Settings
AOL lets you adjust a wide variety of settings to customize your AOL experience. You need to be 
signed on to the AOL service in order to make adjustments to most settings. Many settings, however, 
can be adjusted whether you’re signed on or not. If you click the Settings icon in the Toolbar when you
are not signed on, you’ll see a list of the settings you can work with. These    settings are briefly 
described in this section, Separate sections follow which discuss each setting in greater detail. 

Accessibility
Accessibility settings let you choose formatting and style sheet options to customize web browsing.

Auto AOL
Automatic AOL, more commonly known as Auto AOL, lets you set up an automatic mail schedule, 
handle newsgroup postings on a regular basis, and download files during periods of inactivity.

Connectivity Settings
Manage your access numbers and how you connect to the internet.

Download Settings
Download settings let you control where downloaded files are stored, how Zip files are handled after 
decompression is complete, and get notification about questionable downloads.

Fast Start
Fast Start stores your custom start-up settings.

Font & Text Settings
Font & Text settings let you specify the font and font size to be used for e-mail, chat and instant 
messages.

Internet Properties
Internet Properties, or AOL Browser Settings, lets you customize your information management 
settings to increase Web browsing performance. Other settings affecting your experience on the 
internet, such as Internet Explorer settings, AOL Wallet, Parental Controls, and Pop-Up Controls, can 
be accessed through AOL Browser Settings.

Mail Settings
Mail settings let you establish automatic guidelines for composing, sending, and receiving e-mail.

Mail Signatures
Mail signatures let you create and edit the signature that you want to appear at the bottom of all e-mail 
messages you send.

Multimedia
Multimedia settings let you customize how AOL handles certain audio, sound, and video files as well 
as whether to display captions where available. This offline setting is only available to members using 
America Online 9.0 Security Edition SE.

Offline Storage
Offline Storage is a special area of hard disk space where you can store files such as e-mail and 
graphics. Offline Storage settings let you determine how often your storage area is backed up, what 
size it should get to before you’re notified, and how large graphics can be for acceptance into storage.



Spelling
Spelling settings let you customize the AOL spell check feature, and allows you to create a customized,
Personal Dictionary.

Toolbar
Toolbar settings allow you to customize your toolbar's appearance and navigation features, choose to 
auto-complete Web address entries, and set your toolbar Quick View. You must be signed on to the 
AOL service to change your toolbar themes or toolbar menus. The Quick View settings are only 
available to members using America Online 9.0 Security Edition SE.



Offline Storage Settings
1 Click the Settings icon on the Toolbar.
2 Click Offline Storage in the Settings window.
3 Select your storage settings and click Save.

The following options are available

Automatically backup my Personal Storage every ___ weeks
When you select this setting, your Personal Storage will be copied and saved on your computer at an 
interval you select (from 1 to 4 weeks). The default setting is four weeks.

Confirm before deleting single items
When you select this setting, a confirmation window appears when you delete individual items from 
Personal Storage. You cannot recover items once they have been deleted from Personal Storage, unless 
you have a backup copy of Personal Storage that contains the item (see first setting).

Confirm before deleting multiple items
When you select this setting, a confirmation window appears when you delete multiple items from the 
Personal Storage at once. You cannot recover items once they have been deleted from Personal 
Storage, unless you have a backup copy of Personal Storage that contains the item (see first setting).

Graphics settings
Set aside up to a gigabyte of space for graphics storage.



Toolbar Settings
1 Click the Settings icon on the Toolbar.
2 Click Toolbar in the Settings window.
3 Select your toolbar settings and click Save.

The following options are available:

General Toolbar
Choose when your Toolbar should be minimized:

· Always: Choose this setting to maximize window size if you don’t typically use the Toolbar 
buttons.

· Never: Choose this setting if you typically use the Toolbar buttons and window size is not an 
issue.

· Only when I have windows maximized: Choose this setting to automatically minimize your 
Toolbar whenever you maximize a window. The Toolbar automatically reappears when you 
restore the window to a smaller size. 

Auto-complete AOL keywords and Web Addresses using My History Trail
If you select this setting, recognized AOL Keywords and Web addresses will automatically fill in as 
you type. Otherwise, you must type the entire AOL Keyword or Web address.

Toolbar Quick View
Display Quick View
This setting is only available to members using America Online 9.0 Security Edition SE. This is 
whether or not you choose to display the Toolbar Quick View. You can also choose the display speed 
for the Quick View. 
You might want to test this setting by clicking the Test button if your computer has less than 128 
megabytes of memory installed or you are having performance problems such as slower interactions 
with the AOL service. 
Once you have made changes to your settings, click Save.

Note
There are a few online settings accessed through the Toolbar Settings page. Clicking the 
hyperlinks in any of the remaining settings
· Change your Toolbar Themes
· Change your Toolbar Menus
· Edit your Toolbar Carousel Settings
opens the AOL Sign on screen and prompts you for a password to sign on (if not already saved).
These are online settings and once signed on to the AOL Service, you will automatically be 
directed to the desired setting page.



Internet Explorer® Settings
1 Click the Settings icon on the Toolbar.
2 Click Internet Properties in the Settings window.
3 Under Related Settings, click Internet Explorer Settings.
4 Select your Internet settings and click OK.

The Internet Explorer dialog box lets you choose a wide range of settings for viewing web pages 
outside of the AOL service. The dialog box has seven tabs, each offering a variety of options: General,
Security, Privacy, Content, Connections, Programs, Advanced.
The great majority of users will find that the default settings that are automatically in effect are more 
than adequate. Therefore, you probably won’t need to use this table at all. If you do, however, you can 
adjust your settings very precisely.
Some of the options available are actually system properties of Internet Explorer, the web browser 
embedded in AOL. As such, you may find Microsoft’s Knowledge Base to be the best source of 
additional information.

General Settings:
The General Settings tab lets you do the following:

· Specify a home page—the page that appears when you open your web browser in AOL.
· Control Temporary Internet File storage—files you’ve viewed are stored in an area whose 

size you can define. They can be saved or deleted as you choose, and you can also specify 
how often newer versions should replace existing files.

· History—you can specify how long to keep files you’ve viewed in the History folder, and 
you can clear the folder at any time.

· Colors—you can specify what colors you want to use for text and background.
· Fonts—you can specify what font and alphabet (if alternatives are available) you want web 

pages to use. Note that this option only applies if the web page doesn’t specify the font to 
use.

· Language Preference—if your computer can display web pages that allow it in a variety of 
languages, this setting lets you choose which one to use.

· Accessibility—this setting lets you substitute a customized style sheet for the display of web
pages. This may make viewing easier for the visually-impaired.

Security Settings:
The Security Settings tab lets you help regulate security for local sites, trusted sites, and restricted sites.
All other sites are grouped into a general Internet zone. 
To assign a site to the local zone, do the following:

1 Click the Local Intranet zone icon.
2 Click the Sites button.
3 Do one of the following:

· Check or uncheck the default settings to indicate which sites should be in the zone.
· Click Advanced, enter the URL for each site you want in the zone, and click OK when 

you’re done.



To designate trusted sites, do the following:
1 Click the Trusted Sites icon.
2 Click the Sites button.
3 Enter the URL for each site you want to include.
4 Optionally, click the Require server verification checkbox.
5 Click OK.

To designate restricted sites, do the following:
1 Click the Restricted Sites icon.
2 Click the Sites button.
3 Enter the URL for each site you want to include.
4 Click OK.

All sites that you have not assigned to one of these zones are automatically assigned to the Internet 
zone.
You can set a security level for each zone using either the custom or default method.

To set the security level using the default method
1 Click the Default Level button.
2 Adjust the slider to a security level of Low, Medium, or High.

To set the security level using the custom method
1 Click the Custom button.
2 In the Security Settings window that appears, click the radio buttons for each option you want to

change.
3 Click OK.

If you want to go back to the default settings, choose a level from the Reset drop-down menu and click 
Reset; then click OK.

Privacy Settings:
The privacy settings tab lets you control whether or not your computer will accept cookies: small bits 
of information that a web site places on your computer. Cookies are essential for 
e-commerce, but they can also be used to abuse your privacy. You have a choice of using Default or 
Advanced privacy guidelines.

To use the Default guidelines:
· Adjust the slidebar to the desired level of cookie control.

Note that you don’t have to click the Default button as the tab opens in the Default state.

To use the Advanced guidelines
1 Click the Advanced button.



2 Click the appropriate radio buttons to accept, block, or ask for a prompt on cookies.

These settings apply to all web sites. To override them for particular sites, click the Edit button and 
enter those sites which you want to set as exceptions.
Depending on your Internet access, Privacy Settings may or may not be available.

Content Settings
Content settings help you control the kinds of content that can be viewed over the Internet. The settings
available here are Microsoft content settings and must be set through Internet Explorer. They can be 
used in tandem with AOL Parental Controls.

Connections Settings
Connection settings let you set up or edit an Internet connection. The AOL Dialer creates a connection 
to the Internet for you.  The AOL Dialer can stay connected even if the America Online software is not 
running. It works with AOL Internet Access Controls, giving parents peace of mind. For more 
information about Internet Access Controls, go to AOL Keyword: Parental Controls.

Programs Settings
Programs settings let you specify which programs Windows uses for each service.

Advanced Settings
Advanced settings let you specify additional settings for the Internet Explorer browser.

For more information, see:
Internet Properties 



Multimedia Settings
1 Click the Settings icon on the Toolbar.
2 Click Multimedia in the Settings window.
3 The following setting options are available:

Player Preferences
Ø Use the AOL Media Player for supported file types

When this setting is selected, the AOL Media Player will start any time you click a link or 
elect to open a multimedia file type that is supported by the AOL software. Disabling this 
setting will not prevent you from using the AOL Media Player to open supported file types 
using the File menu.

Ø Use the AOL Media Player as my default CD player
When this setting is selected, the AOL Media Player will start any time you insert an audio
CD into the CD ROM drive on your computer. If your computer is set up to play CDs 
automatically when they are inserted into the CD drive, the AOL software will start 
automatically before the Media Player window is opened.

Accessibility Preferences
Ø Display captions when available

When this setting is selected, closed captioning information will be displayed when any 
area that supports it is visited.

Ø Display advanced themes for Teens and Kids
When this setting is selected, Teens and Kids screen names can use advanced themes to 
control the appearance of their desktop, toolbar, buddy list, buddy icon, and wallpaper 
(available at AOL Keyword: Themes). Clear this setting if you use the AOL service with a 
screen reader or if you primarily use the keyboard to interact with the AOL service. You 
might also want to clear this setting if your computer has less than 128 megabytes of 
memory installed or you are having performance problems such as slower interactions 
with the AOL service.

Sound Settings
Ø Enable AOL sounds such as the Welcome greeting and Instant Message chimes

When this setting is selected, AOL sounds are enabled.
4 Select your multimedia settings and click Save.

Note
These settings are only available to members using AOL 9.0 Security Edition SE.



Auto AOL Settings
1 Click the Settings icon on the Toolbar.
2 Click Auto AOL in the Settings window.
3 Click the checkboxes for the Auto AOL features you want to use.

Notes
Automatic AOL Settings allow you to schedule your computer to sign onto AOL to:

· Send e-mail you composed.
· Retrieve your new, unread e-mail.
· Download files that are attached to your unread e-mail.
· Send and retrieve newsgroup posts.
· Download files you have collected in your Download Manager.

In the Automatic AOL settings you can set the following:
· The times that your computer signs onto AOL by clicking Schedule Automatic AOL.
· The screen names that will sign onto AOL and download files or check e-mail and 

newsgroup postings with the Select Names button.
· The actions you'd like Automatic AOL to run for you (sending and retrieving e-mail and 

newsgroup posts and downloading files).
· You can also Run Automatic AOL at any time you are online by clicking Run Automatic 

AOL Now. First-time users can click Walk Me Through for simple, step-by-step assistance 
in setting up Automatic AOL.



Spelling Settings
Spelling Settings determine what the AOL Spelling and Grammar Checker correct in your e-mail, 
instant messages, chat and message board postings. 
To change AOL Spelling and Grammer Checker settings

1 Click the Settings icon on the Toolbar.
2 Click Spelling in the AOL Settings window.
3 Select or clear the appropriate checkboxes to determine the errors you want checked.

· Ignore words with ALL CAPITALS
· Ignore words with mixed case
· Ignore repeated words
· Ignore HTML Markups (default is checked, or ON)
· Ignore Domain Names (default is checked, or ON)
· Auto-correct misspelling in mail
· Underline misspellings in mail as I type (default is checked, or ON)
· Check grammar in mail (default is checked, or ON)

Grammar 
The following Grammar checker settings all default as checked, or ON. Click any of the 
following settings where you want to turn off Grammar Checker:
· Report double-negatives
· Report redundant-usage
· Report possessives
· Report run-on sentences
· Report improper verb tense
· Report improper noun/verb agreement

4 Once you’ve finished making your changes, click Save to keep the AOL spelling and Grammar 
Checker settings.

To make changes in your Personal Dictionary
· Click Edit My Personal Dictionary to add or remove words in your Personal Dictionary.You 

must have a Personal Dictionary for this option to be usable.

For more information, see:
About Personal Dictionary 
About Settings 



About Personal Dictionary
You can create your own dictionary for use with AOL Speller and Grammar Checker, which can 
include any words or terms you add. Once you’ve added words to your personal dictionary, you can 
remove them at any time.
To create or add words to a Personal Dictionary

1 Click the Settings icon on the Toolbar.
2 Click Spelling in the AOL Settings window.
3 Click Edit My Personal Dictionary. The Personal Dictionary window opens.
4 Type in a word, and click Add to add it to the dictionary.
5 Click Save to save your Personal Dictionary.

To remove words from a Personal Dictionary
1 Click the Settings icon on the Toolbar.
2 Click Spelling in the AOL Settings window.
3 Click Edit My Personal Dictionary. The Personal Dictionary window opens.
4 Select the word you want to remove, and click Remove to erase it from the dictionary.
5 Click Save to save your Personal Dictionary.

For more information, see:
Spelling Settings 
About Settings 



Font & Text Settings
1 Click the Settings icon on the Toolbar.
2 Click Font & Text in the Settings window.
3 Select the font you want to use as your default for writing e-mail, instant messages, and 

chatting, then click Save.
4 Select a font size.
5 Select a font color.

Note
Font & Text settings let you customize the text you type in e-mail, chat, and instant messages. 
You can control the font (including typeface and point size), style (bold, italics, underline), text 
color, text background color, and page background color.



Mail Settings
1 Click Settings on the toolbar.
2 Click Mail Settings in the Settings window.
3 Select your e-mail settings in the Read Mail, Write Mail, and General Settings tabs.
4 Click Manage Saved Mail, and specify if you want your saved mail to be backed up, restored, 

or compacted.
5 Click Save.

Notes
In the Read Mail tab, make the following selections:

· Show addresses as Buddy Info links.
· Ask for notification before mail with pictures is opened.
· Hide images and disable links in mail from unknown senders.
· Automatically display the next message when the current message is deleted.
· Retain all mail in your Saved Mail folder.
· Specify how you want to treat mail you’ve read that has expired
· Specify how you want to display mail headers (the message list)

In the Write Mail tab, make the following selections:
· Use your Address Book and Buddy List® feature to auto-suggest names when sending e-

mail.
· Set up an automatic reminder if there is mail waiting to be sent.
· Present picture quality options when inserting pictures.
· Confirm when mail is to be sent later.
· Perform an automatic spell check before mail is sent.
· Close sent mail.
· Confirm that mail has been sent.
· When replying to messages, choose how you want to quote the original message
· Retain all sent mail in the Mail I've Sent folder.
· Specify how you want to treat mail you’ve sent that has expired.

In the General Settings tab, make the following selections:
· Specify whether you want to see mail from everyone or only from people you know.
· Set your Default Mailbox view to New, which shows only new mail, or Manage mail, which

shows both new mail and the mail folders you have on your computer.
· Specify how you want to sort mail in your mailbox.
· Play a sound when new mail arrives.
· Retain all embedded images in read mail.





Download Settings
1 Click Settings on the AOL toolbar.
2 Click Download Settings in the Settings window.
3 Choose your download settings.
4 Click Save.

You can also click the Preferences button in the Download Manager and make the same choices.
The following options are available

Notify me before downloading questionable files
When you select this preference, a confirmation appears before you download certain file types 
(graphic images or executable files). Selecting this preference does not prevent you from downloading 
these types of files. If you don't know the person who sent the e-mail, you may not want to download 
the file, since it could contain an objectionable image or a computer virus.

Automatically display images after downloading
When you select this preference, AOL will open and display graphics files as you download them. 
Otherwise, you must open the file (either with AOL or another graphics program) to view the file after 
you download it.

Confirm when I add files to my download list
When you select this preference, AOL will ask you to click OK each time you add a file to your 
Download Manager. Otherwise, files are added to the Download Manager without notification.

Delete ZIP files after they are decompressed
When you select this preference, AOL will delete the compressed file, leaving expanded contents in 
your download folder. Otherwise, the compressed file is not deleted.
Retain information about my last ___ downloads
When you select this preference, AOL will keep track of recent downloads (in the Download 
Manager). Use the arrows or enter a number to specify how many previously downloaded files AOL 
keeps track of. Otherwise, the Download Manager does not retain any information about the files you 
download.

Put files I download in the following directory:
By default, files are downloaded to the My Documents folder. You can change this if you prefer. Type 
the name of the new folder you want to use for future downloads, or click Browse to navigate your 
hard drive.

Automatically decompress ZIP files:
Select when (or if) you want compressed files automatically expanded after you download them.

· When I download them
· When I sign off
· Do not decompress

For more information
About Downloading 



About the Download Manager 
Downloading Files 



Accessibility Settings
1 Click Settings on the AOL toolbar.
2 Click Accessibility in the Settings window.
3 Click Accessibility in the General tab.
4 Choose your settings.
5 Click OK.

Notes
The following options are available:

Formatting
· Specifies whether you want the browser to always use the colors, font styles, and font sizes 

you choose for text, background, and links.

User Style Sheet
· Specifies whether you want the browser to use your own style sheet to format web pages 

when they are displayed, and provides a place for you to type the path to your style sheet. 
Style sheets can specify the default font style, size, colors, and background for text and 
headings.



Mail Signatures Settings
1 Click Settings on the AOL toolbar.
2 Click Mail Signatures in the Settings window.
3 Choose your settings.
4 Click OK.

Notes
The following options are available:

Create
· Lets you create a new mail signature.

Edit
· Lets you edit an existing mail signature.

Delete
· Lets you delete a mail signature.

Default On/Off
· Lets you designate or turn off the default mail signature. The default mail signature is 

identified by a checkmark.



Internet Properties
AOL Browser Settings (Internet Properties) let you control how your browser handles information so 
that you can increase performance while surfing the Web. 

To access AOL Browser Settings
1 Click Settings on the AOL Toolbar.
2 Click Internet Properties on the AOL Settings window.

TopSpeed™ Technology – AOL’s Web Browser Accelerator
The AOL Browser Settings window lets you turn the AOL TopSpeed™ Web Browser Accelerator on
or off. This AOL exclusive feature speeds up Web browsing remarkably. For a demonstration, go to 
AOL Keyword: TopSpeed. Click Help in that form to read informative articles about TopSpeed. It's on 
by default unless you have a firewall. For more information about firewalls, sign on to the AOL service
and go to AOL Keyword: Safety. 
The AOL Browser Settings window also lets you determine whether or not you want graphics to be 
compressed, to more quickly display Web pages. Choose the setting that's best for you depending on 
whether or not you need to save graphic files and/or the method you use to connect to the Internet.
In addition, the AOL Browser Settings window links you to related settings for Internet Explorer, the 
AOL Wallet, Parental Controls, and Pop-Up Controls.

To turn the AOL TopSpeed ™ Web Browser Accelerator off
1 In the top half of the AOL Browser Settings window, TopSpeed™ tab, click to deselect the Turn

on AOL TopSpeed checkbox. 
2 Click Save.

Web Graphics Compression
The web graphics compression affects download times and graphics quality. You can adjust the settings
as follows:

1 From the Web Graphics Compression section of the AOL Browser Settings window, 
TopSpeed™ tab, select one of the following:
· Compress graphics only when I don’t have a high-speed connection (Recommended).
· Always compress graphics.
· Never compress graphics.

2 You can also improve download times by turning on maximum graphics compression. However,
image quality will be reduced. To choose this setting,
· Click Turn on maximum graphics compression.

3 Click Save.

For more information, see:
Internet Explorer Settings 





Using Print Setup
1 On the File menu, click Print Setup. 
2 In the Print Setup dialog box, do any of the following: 

· To change the paper or envelope size, click a size in Size. 
· To change the paper source, click a tray name or a feeder in Source. 
· To print the document vertically, click Portrait; to print the document horizontally, click 

Landscape. 
· To change your printer settings, click Properties.

3 Click OK when you are done setting your printing options.

For more information, see:
Using Print Preview 
Printing a Web Page 



Using Print Preview
The Print Preview feature lets you look at a page before it is printed.

1 On the File menu, click Print Preview. 
2 In the Print Preview dialog box, do any of the following: 

· View a preview of each page: Click the forward or backward arrows to move between 
pages.

· Increase or decrease the scale (size) of the pages. Use the magnifying glass buttons or 
choose a value from the drop-down menu.

· Customize the pages with headers, footers, and different margins. You can also change the 
paper size, source, and orientation. Click the Page Setup button next to the Print button.

3 Click Print to print your pages.
4 Click the Close button to return to the page.

For more information, see:
Using Print Setup 
Printing a Web Page 
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About the AOL Tray Icon
You can find the AOL tray icon in the Windows system. By clicking the icon once, you can open several
menu options to handily access AOL settings or frequenly used options, such as signing on to the 
service.
The AOL tray icon is automatically added to your Windows system tray when you install AOL 9.0.
Click any of the links below to find more information about the menu options available from the AOL 
System Tray.
Signing On To the AOL Service 
Start-Up Settings 
Help 
AOL Spyware Protection 
AOL System Information 



Signing On To the AOL Service
To sign on to the AOL Service

1 On the AOL Sign On screen, select the screen name you want to sign on with from the 
screen name menu. 

2 Type the password for that screen name in the password field. 
3 Click Sign On.

For more information
What if I forget my AOL password? 
Solving Common AOL Problems 



About Offline Message Boards & Newsgroups
Offline Message Boards & Newsgroups helps you organize message board and newsgroup posts 
retrieved online by Automatic AOL (unread message boards and newsgroups) and items assembled for 
the next time Automatic AOL is activated (outgoing message board and newsgroup posts).

· To open your Offline Message Boards & Newsgroups, go to the Community menu on the 
AOL toolbar, and click Message Boards.

You cannot access your Offline Message Boards & Newsgroups if you sign on as a Guest from another
member's computer.



Adding Folders to Offline Message Boards & Newsgroups
You can add folders to Offline Message Boards & Newsgroups.
To add folders to Offline Message Boards & Newsgroups

1 On the Community menu on the AOL toolbar, click Message Boards.
2 Click the location for the new folder.
3 Click Add Folder, and then type the name of the new folder.



Deleting Items from Offline Message Boards & Newsgroups
1 On the Community menu on the AOL toolbar, click Messages Boards or Newsgroups.
2 Click the item you want to delete.
3 Click Delete. A confirmation window will appear asking if you are sure you want to delete the 

item. Click Yes to complete the deletion.

Notes
· To access Offline Message Boards & Newsgroups for other screen names on your account, 

select a different screen name from the Select Screen Name list on the Sign On screen.
· You can use multiple selection techniques to select more than one item at a time for 

deletion.
· If you delete a folder, you will also delete all items inside the folder.
· You can only delete folders you have created within Offline Message Boards & 

Newsgroups.



Rearranging the Contents of Offline Message Boards & Newsgroups
1 On the Community menu on the AOL toolbar, click Message Boards or Newsgroups.
2 Drag a folder or file to a new location under Newsgroups.

For more information, see:
About Offline Message Boards & Newsgroups 
Adding Folders To Offline Message Boards & Newsgroups 
Deleting Items From Offline Message Boards & Newsgroups 



Recovering Unused Space in Offline Message Boards & 
Newsgroups

1 In the Community menu on the AOL toolbar, click Message Boards or Newsgroups.
2 Click Manage, and then click Compact.

Note
When you delete files from Offline Message Boards & Newsgroups, the database file is not 
compacted. The empty space on your computer is not reclaimed until you run this utility.



Backing Up the Information in Offline Message Boards & 
Newsgroups
Backing up Offline Message Boards & Newsgroups lets you safeguard the information you have stored
there. In the event you experience a problem, it is easy to restore lost information.
You can back up your posts manually or you can set a preference to do it automatically at a desired 
interval.
To manually back up Offline Message Boards & Newsgroups

1 On the Community menu on the AOL toolbar, click Message Boards.
2 Click Manage and then select Backup.
3 Click Backup Now.

To set a preference to automatically back up Offline Message Boards & Newsgroups
1 On the Community menu on the AOL toolbar, click Message Boards.
2 Click Manage, and then select Backup.
3 Click Preferences. 

For more information, see:
About Offline Message Boards & Newsgroups 
Restoring The Information In Offline Message Boards & Newsgroups 



Restoring the Information in Offline Message Boards & Newsgroups
In the event you experience problems with your Offline Message Boards & Newsgroups and lose its 
contents, it is easy to restore information that you previously backed up.
To restore Offline Message Boards & Newsgroups

1 On the Community menu on the AOL toolbar, click Message Boards or Newsgroups.
2 Click Manage, then select Restore. 
3 Click Yes to restore the previously backed up contents of Offline Message Boards & 

Newsgroups.

Notes
· You can only use the Restore command if you have previously backed up the contents of 

Offline Message Boards & Newsgroups.
· When you use the Restore command, you replace the current contents of Offline Message 

Boards & Newsgroups with your backup copy. Once you do this, you will not be able to 
access the contents of the current Offline Message Boards & Newsgroups.

For more information, see:
About Offline Message Boards & Newsgroups 
Backing Up The Information In Your Message Boards & Newsgroups 



Searching Offline Message Boards & Newsgroups
1 On the Community menu on the AOL toolbar, click Message Boards.
2 Click Find.
3 Specify the search criteria.

Note
You can use a more limited search function, Find in Top Window, on the Edit menu, anywhere
on the service.

For more information, see:
About Offline Message Boards & Newsgroups 



Selecting Multiple Items to Move or Delete From Offline Message 
Boards & Newsgroups

1 On the Community menu on the AOL toolbar, click Message Boards or Newsgroups.
2 Hold down the CTRL key, and click each item you want to select.

Notes
· Hold down the Shift key and click two unconnected items to select all items in between.
· Hold down the CTRL key and click a selected item to undo the selection.

For more information, see:
About Offline Message Boards & Newsgroups 



Reading and Responding to Message Board & Newsgroup Postings 
When You Aren't Signed On

1 On the Community menu, click Message Boards.
2 In the Incoming/Saved Postings folder, double-click the message you want to read.
3 Highlight a section of text to select it, if you want to quote it in your response.
4 Click Reply to Group to send a response to the message board or newsgroup (or Reply to 

Author if you want to send a private e-mail as a response).
5 Compose your response to the quoted material and click Send Later.

Notes
· If you click Reply to Author, you will need to set up Automatic AOL to send outgoing mail

before your response will be sent.
· The ability to use automatic quoting in replies to newsgroup messages is only available on 

messages retrieved by Automatic AOL and responded to from Message Boards & 
Newsgroups.

For more information, see:
About Automatic AOL 
Setting Up Automatic AOL To Send Or Retrieve Postings 
About Newsgroups 



Selecting Message Boards to Read When You Are Not Signed On
1 Sign on to the America Online service.
2 Go to AOL Keyword: Message Boards.
3 Open the message board that you want to read offline.
4 Click Add to My Boards. You cannot add message boards containing other message boards.
5 In the message board window, click My Boards.
6 Click the folder once to select it and click Read Offline. The icon for the folder will change 

color. 

For more information, see:
About Automatic AOL 



Selecting Newsgroups to Read When You Are Not Signed On
1 Sign on to the America Online service.
2 Go to AOL Keyword: Newsgroups.
3 Click Read Offline.
4 Select newsgroups from your Subscribed Newsgroups to add as Newsgroups to Read Offline.

For more information, see:
About Newsgroups 
About Automatic AOL 
Setting Up Automatic AOL to Send/Retrieve Message Board and Newsgroup Postings 
Reading and Responding to Newsgroup Postings When You Aren't Signed On 
 



Setting Up Automatic AOL to Send/Retrieve Message Board & 
Newsgroup Postings

1 On the Mail menu on the AOL toolbar, click Set Up Automatic AOL.
2 Select the checkbox labeled: Send postings from the "Postings Waiting to be Sent" folder.
3 Select the check box labeled: Get unread postings and put in "Incoming Postings" folder.
4 Click Select Names and select a screen name and type your AOL password, then click OK.
5 Click the X in the upper right corner of the Automatic AOL screen to close it.

Notes
· Anyone who has physical access to your computer can sign on to your account if you store 

your password.
· If you decide not to store your passwords, you can sign on to America Online with each 

screen name and start Automatic AOL manually while you are online.

For more information, see:
About Automatic AOL   
About Newsgroups 
Reading And Responding To Postings Offline 
Selecting Newsgroups To Read Offline 
Storing Passwords For Automatic AOL 



About Newsgroups
Newsgroups allow you to communicate with other people interested in particular topics. They are 
similar to the message boards that you find in AOL, but offer a wider range of topics and participants.

Newsgroup names
Newsgroups are organized by category or topic into "hierarchies." Newsgroup names show the position
of the topic in the hierarchy. (AOL also gives you descriptive names for some newsgroups.) For 
example:
rec
Indicates a recreational newsgroup. Other top-level names are alt (for alternative), biz (for business) 
news, and so forth.
rec.autos
Indicates a recreational newsgroup about cars.
rec.autos.antique
Indicates a recreational newsgroup about antique cars.
rec.autos.makers.honda
Indicates a recreational newsgroup about the automobile manufacturer Honda.

Moderated and unmoderated newsgroups
In moderated newsgroups, a person or group of people reviews each message before it is posted to the 
newsgroup. The content of moderated newsgroups is usually better because only messages that are 
relevant to the topic are posted. The word "moderated" appears in the title of moderated newsgroups.
Most newsgroups are unmoderated, but there are rules about what you should post, which you can find 
in the newsgroup's list of frequently asked questions (called FAQs). If you "lurk" (read without 
posting) for a couple of weeks, you'll get a good sense of what is allowed.

Note
Some newsgroups may contain objectionable content. Although AOL cannot review each group 
and give appropriate warnings, AOL does provide Parental Controls found at AOL Keyword: 
Parental Controls to limit minors' access to these groups.



Newsgroup Netiquette
"Netiquette" refers to the polite and considerate treatment of others on the Internet. Here is a list of 
suggested guidelines for participating in newsgroups:

Read Before Participating
Read a group or list for a while before you post your first message. This allows you to become familiar 
with the participants, topics, and tone of the group. Reading a group without posting messages to it is 
sometimes called "lurking."

Communicate Clearly
Write clearly when you compose a message. Review your message for spelling and typos. If your 
message can be misunderstood, it will be.

Refrain from using ALL CAPS
Typing in all capital letters is considered to be the equivalent of screaming. It also makes your message
more difficult to read. (SEE HOW ANNOYING AND DIFFICULT IT CAN BE?)

No Chain Letters or Advertisements
Chain letters are never appreciated in the online community, and they're a violation of your 
membership agreement with AOL. Advertisements are equally unwelcome, though there are some 
newsgroups designed just for this purpose. Please limit your ads to those areas, or go to AOL 
Classifieds at Keyword: Classifieds and post an ad there.

No "Me Too's"
"Me too" messages add nothing to the value of a newsgroup. If you agree with a posting, either enjoy 
your consent by yourself or reply with an informative comment about why you agree.

Be Kind
Don't issue personal attacks, use profanity, or betray a confidence. Rude or hostile verbal attacks 
(called "flaming") are strongly discouraged. Disagreements are fine, but please limit your responses to 
a discussion of the topic and avoid attacks upon another individual.

Refrain from Cross-Posting
Cross-posting means posting a single message to several different newsgroups, and it is almost never 
appropriate. Such posts reduce the quality of the discussion and needlessly increase the traffic on the 
board. Find the best place for your post, and confine your message to one newsgroup.

Express Yourself with 'Emoticons'
Emoticons are human-face drawings composed of text characters. They help express emotions online --
for more dynamic communication. Here are just a few (tilt your head to the left to see the effect):
:) = smile
;) = wink
:( = frown
>:-) is a devil
0:-) is an angel

For more information, see:
About Newsgroups 





Newsgroup Terms
Cross-posting
Posting a single message intended for several newsgroups. AOL members cannot cross-post by 
creating a new message. Cross-posting is almost never appropriate. Such posts (and cross-posted 
threads) tend to reduce the quality of the discussion and needlessly increase the traffic in newsgroups.

Emoticon
Emoticons are the drawings composed of text characters that allow for a show of emotion (hence the 
name emoticon) on the Internet. Here are just a few (tilt your head to the left to see the effect): :) is a 
smile. ;) is a wink. >:-) is a devil. 0:-) is an angel.

English-style names
The descriptive title given to a newsgroup by either the newsgroup's founders or by AOL (AOL 
provides a descriptive name if the group did not have one when it was created). For example, "Anxious
talk" is the English-style name for "alt.angst." You can set your preferences to show newsgroups by 
either the English-style name or the Internet-style name. To set this preference, from the main 
Newsgroup window, click Set Preferences.

FAQ
FAQs (Frequently Asked Questions) are documents defining a newsgroup's focus and intent. They also 
generally discuss netiquette for the group. It's good netiquette to read a newsgroup's FAQ before 
posting to it.

Flame
Flames are posts that are hostile, rude, or otherwise confrontational.

Flame war
A thread or series of threads and messages that is composed of flames. It is usually best to ignore a 
flame war.

Internet-style names
An Internet-style name is the full Usenet name. For example, "alt.angst" is the Internet-style name for 
"Anxious talk" (the English-style name). For more information about newsgroup names, read About 
Newsgroups.

Lurk
To subscribe to a group and read through the posts before offering your own contribution. Lurking 
helps you find out what has already been said and how the newsgroup works.

Message
The unit of newsgroups. It is the information you want to share with the group. Synonyms include 
"post," "posting," and "article."

Moderated
Newsgroups that have one or more individuals (called a moderator) who decide to allow a message to 
be posted for the whole group to see. The moderator's job is to keep conversations on topic and keep 
junk out of the group. Most newsgroups are unmoderated.

Netiquette
The recommended conduct of individuals on the Internet. For more about netiquette, read About 



newsgroup netiquette.

Signature or .sig
Signatures are composed of text messages that are attached to all of your posts. They can contain your 
name, Web address, business information, or quotations that you associate with yourself. Signatures 
longer than four to five lines are generally considered a waste of people's time and network bandwidth.

Thread
Smaller conversations originating with a single post within the larger topic of the newsgroup. For 
example, a group about pets may contain threads about dogs, cats, iguanas, or other animals.

Troll
A person who makes posts that are meant to make people angry or otherwise provoke them. For 
example, posting a message in a Macintosh-focused newsgroup that states Macintoshes are inferior to 
PCs would certainly either provoke a flame, or be ignored.

For more information, see:
About Newsgroups 





About the Media Player Feature
The Media Player feature is an easy-to-use, integrated feature of the AOL software. That means you 
don't have to download and install any additional software to enjoy playing sound and video files you 
have stored on your computer, or streaming audio or video files you encounter online. (Streaming 
audio and video files play "on the fly" and are never completely downloaded to your computer.)
The Media Player supports the following sound and video formats:

· WAV
· MIDI
· MP3, including MP1, MP2
· PLS, M3U playlists
· Shoutcast, receipt/playback of streaming MP3
· MPEG video
· AVI
· RealPlayer Files (RA, RAM, RM, RMJ, AVI, MPG, MPEG, RT, SMIL)
· Windows Media Player Files (WMA, ASF, ASX, WM, WMV)**
· Quicktime files (QT, MOV, QTL)

** Only when Windows Media Player 7.0 or higher is present on your computer.

Note
The Media Player feature is only available to members using AOL 9.0 Security Edition SEcurity
Edition SE.



About the My PlaylistTM Feature
You can create and save customized playlists using the My Playlist feature. Playlists are customized 
lists of audio files, which you have organized to play in a certain order. You can create a playlist from 
audio files you have saved on your computer. Once you have created and saved a playlist, you can edit 
the playlist and add new files, remove files, or change the order of the files in the list.

Note
The Media Player feature is only available to members using AOL 9.0 Security Edition SEcurity
Edition SE.



Playing an Audio File
1 On the File menu (above the AOL toolbar), click Open.
2 Navigate to the folder on your computer where the audio file is located.
3 Double-click the file to open it.
4 If the file does not automatically begin to play, click the Play button in the AOL Media Player 

window.

Notes
· The Media Player feature is only available to members using AOL 9.0 Security Edition 

SEcurity Edition SE.
· Hold your mouse over a function button on the Media Player for a few seconds and a help 

message will appear telling you what the button does.
· To play a streaming audio file found at a Web site, just click the link to begin playing the 

file.

For more information, see:
About The Media Player Feature 
About The My Playlist Feature 



Playing a Video File
1 On the File menu (above the AOL toolbar), click Open.
2 Navigate to the folder on your computer that contains the video file you want to play.
3 Double-click the file to open it.
4 If the file does not automatically begin to play, click the Play button in the AOL Media Player 

window.

Notes
· To play a streaming video file found at a Web site, just click the link to begin playing the 

file.
· The Media Player feature is only available to members using AOL 9.0 Security Edition 

SEcurity Edition SE.

For more information, see:
About The Media Player Feature 
About The My Playlist Feature 



Creating a Playlist from Audio Files on Your Computer
1 On the File menu (above the AOL toolbar), click Open.
2 Navigate to the folder that contains your audio files and double-click the first audio file you 

want to add to the playlist.
3 In the AOL Media Player window, click My Playlist.
4 In the AOL Playlist Editor window, click Add Item.
5 Navigate to the folder that contains your audio files.
6 Select the file(s) you want to add to the playlist (hold down the CTRL key to select more than 

one file) and click Open.
7 If you want to save the list to listen to again later, click Save.

To create a playlist of streaming audio files from a web site
1 Navigate to a site that contains streaming audio files you want to hear.
2 Click the links to the audio files to add them to your playlist.

 To listen to the playlist later
1 On the File menu (above the AOL toolbar), click Open.
2 Navigate to the folder that contains the playlist you want to hear, and double-click it to open it. 

The first audio file in the playlist begins to play automatically.

Notes
The My Playlist and Media Player features are only available to members using AOL 9.0 
Security Edition SEcurity Edition SE.

For more information, see:
About The Media Player Feature 
About The My Playlist Feature 



Adding New Audio Files to an Existing Playlist
1 On the File menu (above the AOL toolbar), click Open.
2 Navigate to the folder on your computer that contains the playlist.
3 Double-click the playlist to open it.
4 In the AOL Media Player window, click My Playlist.
5 In the AOL Playlist Editor window, click Add Item.
6 Navigate to the folder on your computer that contains the audio file(s) you want to add.
7 Select the file(s) you want to add to the playlist (hold down the CTRL key to select more than 

one file) and click Open.
8 Click Save.

Notes
· The Media Player feature is only available to members using AOL 9.0 Security Edition 

SEcurity Edition SE.
· To begin listening to the playlist, select the first item in the list and click Play.

For more information, see:
About The Media Player Feature 
About The My Playlist Feature 



Changing the Order of Audio Files in a Playlist
1 On the File menu (above the AOL toolbar), click Open.
2 Navigate to the folder on your computer that contains the playlist.
3 Double-click the playlist to open it.
4 In the AOL Media Player window, click My Playlist.
5 In the AOL Playlist Editor window, select an item to move.
6 Click the arrows to the right of the list to move the item up or down in the playlist.
7 Click Save.

Note
The My Playlist and Media Player features are only available to members using AOL 9.0 
Security Edition SEcurity Edition SE.

For more information, see:
About The Media Player Feature 
About The My Playlist Feature 



Removing Audio Files From a Playlist
1 On the File menu (above the AOL toolbar), click Open.
2 Navigate to the folder on your computer that contains the playlist.
3 Double-click the playlist to open it.
4 In the AOL® Media Player window, click My Playlist.
5 In the AOL Playlist Editor window, select the audio file you want to remove from the playlist, 

and click Remove Item.
6 Click Save.

Note
The My Playlist and Media Player features are only available to members using AOL 9.0 
Security Edition SE.

For more information, see:
About The Media Player Feature 
About the My Playlist Feature 



Making the AOL®    Media Player Your Default CD Player
You can choose to make the AOL Media Player your default CD player. After you have set this 
preference, the AOL Media Player will start any time you insert an audio CD into the CD ROM drive 
on your computer. 
To make the AOL Media Player your default CD player

1 Click the Settings button on the AOL toolbar.
2 In the AOL Settings window, click Multimedia.
3 In the Player Preferences section, select the Use the AOL Media Player as my default CD 

player check box.
4 Click Save.

Notes

· The Media Player feature is only available to members using AOL 9.0 Security Edition SE.
· The opportunity to make the AOL Media Player your default CD player is offered after you 

install the AOL 9.0 Security Edition SE software.
· Once you make the AOL Media Player your default CD player, and if your computer is set 

up to play CDs automatically when they are inserted into the CD drive, then the AOL Media
Player software automatically starts. 

· If you would like to use another program as your CD player, clear the Use the AOL Media 
Player as my default CD player check box.



Playing Audio CDs using the AOL® Media Player
To play an audio CD using the AOL Media Player

1 Insert the CD into your CD ROM drive.
2 On the File menu above the AOL toolbar, click Open CD/Media Player.

Notes
· The Media Player feature is only available to members using AOL 9.0 Security Edition SE.
· The Open CD/Media Player feature is only available to members using AOL 9.0 Security 

Edition SE.
· If you have made the AOL Media Player your default CD player, and your computer is set 

up to play CDs automatically when they are inserted into the CD drive, then you will not 
need to perform step 2 listed above unless you insert a mixed-media CD (one that contains 
both data and music). 

For additional assistance, consult the help documentation for your operating system (On the 
Windows Start menu, click Help).

· If you wish to replay a CD that is already in your CD ROM drive click the Play button on 
the AOL Media Player window (if the Player is running), or click Open CD/Media Player
on the File menu (if the Player is not running).



Viewing a List of Song Names for an Audio CD
To view a list of song names for an audio CD

· On the AOL Media Player window, click View CD Tracks.

Notes
· The Media Player feature is only available to members using AOL 9.0 Security Edition SE.
· A CD must be in your CD ROM drive for this feature to work. 
· If you don’t see your CD tracks listed in the AOL CD Player Tracks window, select 

another CD drive from the list of CD drives. 
· Song names are retrieved using the Gracenote CDDB® database and stored on your 

computer. You must be signed on for this retrieval to take place. This means that specific 
song names will not be displayed if you play a particular CD for the first time when you are 
not signed on. 

· Song names are not available for all CDs. When song names are not available, the tracks 
will be listed by numbers (e.g., Track 1, Track 2, etc.).



Adjusting the Volume of Audio or Video Playback
To adjust the volume of audio or video playback

· On the AOL Media Player window, move the volume slider (next to the picture of a 
speaker) up or down until the desired volume setting is reached.

Notes
· The Media Player feature is only available to members using AOL 9.0 Security Edition SE.
· The speakers that came with your computer may have their own volume controls. If the 

volume is too loud or too soft even after you have made adjustments using the AOL Media 
Player volume slider, you will need to use the controls on your speakers. Consult the 
manuals or other documentation that came with your computer for more information.



About the CD Tracklist
When an audio CD is in your CD drive and the AOL Media Player is running, you can click View CD 
Tracks to see a list of song names. You can play any song from this window by clicking the song name
once to select it, and then clicking Play Track.

Notes
· The Media Player feature is only available to members using AOL 9.0 Security Edition SE.
· Song names are retrieved using the Gracenote CDDB® database and stored on your 

computer. You must be signed on for this retrieval to take place. This means that specific 
song names will not be displayed if you play a particular CD for the first time when you are 
not signed on. 

· Song names are not available for all CDs. When song names are not available, the tracks will
be listed by numbers (e.g., Track 1, Track 2, etc.).

· If you insert a different CD while the AOL CD Player Tracks window is visible, or if you 
first inserted the CD when you were not signed on, click Refresh List to retrieve a list of 
song names.

· The CD Tracklist cannot be reordered, nor can songs on an audio CD be added to an AOL 
Media Player playlist.





About My Picture Finder
My Picture Finder allows you to preview pictures and decide which ones to add to your e-mail.    While
offline, you will be able to access the My Computer tab, which shows pictures stored on your hard 
drive.    Here you can select your picture(s), enhance them, and insert them into your e-mail.
To open My Picture Finder

· From the File menu, choose Open My Picture Finder. 

Note
When you hover your mouse over an image, information about that picture appears, including 
the file name, date last modified, and file size.

For more information, see:
Using My Picture Finder To Send Pictures In E-Mail 
Editing Pictures In My Picture Finder  



Editing Pictures in My Picture Finder
After selecting the picture(s) you want to add to your e-mail, you can enhance, repair, and prepare your
selection by using the available tools.    Note that you can only edit one picture at a time.    

To edit a picture
· Double-click the picture. The Edit Picture screen opens.

Available Edit functions include
Auto Enhance 
Brightness & Contrast 
Red Eye Reduction 
Crop Image 
Convert To Grayscale 
Convert To Sepia 
Zoom 
Fit To Window 
Flip Horizontally Or Vertically 
Rotate 

After editing the picture
· Click Save to overwrite your image, or Save as a Copy to save the edited version into a 

new file. Your original image will not be changed.

For more information, see:
About My Picture Finder 
Using My Picture Finder To Send Pictures In E-Mail 



Using My Picture Finder to Send Pictures in E-Mail
To access My Picture Finder

1 On the File menu, click Open My Picture Finder. 
2 From the My Computer tab, which shows pictures stored on your hard drive, select the folder 

containing the photos you’d like to send. Pictures will be displayed in the My Picture Finder 
window.    

3 Choose the picture(s) you want to insert by clicking in the checkbox next to the picture (or click 
Select All).

4 Click Insert in Mail to add your selected picture(s) into your e-mail message. 

For more information, see:
About My Picture Finder 
Editing Pictures In My Picture Finder 



Inserting a Picture In E-Mail
To insert a picture in e-mail

1 On the Write Mail form, click the Camera icon to open the Fun Mail list of options.    Choose 
Insert Picture.

2 From the My Computer tab, which shows pictures stored on your hard drive, select the folder 
containing the photos you’d like to send.    Pictures will be displayed in the Insert Pictures 
window.    

3 Choose the picture(s) you want to insert by clicking the checkbox next to the picture (or click 
Select All). 

4 Click Insert to add your selected picture(s) into your e-mail message. 

Note
If you insert pictures in e-mail when you are signed on to the AOL service, you will be able to 
create photo layouts in your e-mail message.

For more information, see:
Editing A Picture 



Editing a Picture
After selecting the picture(s) you want to add to your e-mail, you can enhance, repair, and prepare your
selection by using the available tools.    Note that you can only edit one picture at a time.    

To edit a picture
· Double-click the picture. The Edit Picture screen opens.

Available Edit functions include
Auto Enhance 
Brightness & Contrast 
Red Eye Reduction 
Crop Image 
Convert To Grayscale 
Convert To Sepia 
Zoom 
Fit To Window 
Flip Horizontally Or Vertically 
Rotate 

After editing the picture
· Click Save to overwrite your image, or Save as a Copy to save the edited version into a 

new file. Your original image will not be changed.

For more information, see:
Using My Picture Finder To Send Pictures In E-Mail 



Brightness & Contrast
The Brightness & Contrast function on the Edit Picture screen allows you to make lighting adjustment
and fine tune your picture. 

· Select Brightness &Contrast to open a sub-screen. To make modifications, use either the 
slider controls or the two corresponding text boxes.

· Drag the slider controls in either right or left direction to adjust your picture.
· You can also make adjustments using the up or down arrows or by entering a numerical 

value in the text box. 
· Use the thumbnail, located in the Original box, to compare your adjusted picture.    
· Click Done to apply any adjustments made to the picture and close the sub-screen. You will 

be returned to the main edit screen and can either save or continue making modifications.

Prior to saving you can
· Click Undo to cancel the last edit action you performed.
· Click Undo All to cancel all edit actions.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· The Undo function will not undo any edits that have been saved.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Crop Image
The Crop function on the Edit Picture screen allows you to remove unwanted portions of your picture.

· Select Crop to open a sub-screen. A dotted box will appear on top of your picture. 
· Move the box by holding down the left mouse button and repositioning it on the area you 

want to keep.
· Change the shape and size of the box by dragging any of its four corners, or by choosing the

custom size option.

To use the Custom size option
1 In the Aspect Ratio dialog box, select your custom size.
2 Select the Orientation by clicking either Landscape or Portrait.

To crop
· Choose Apply and the area of the picture not covered by the dotted box will be removed. 

Prior to saving you can
· Click Undo to cancel the last edit action you performed.
· Click Undo All to cancel all edit actions.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· Aspect ratio is the relationship between the height and width of your photograph.
· The Undo function will not undo any changes that have been saved.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Auto Enhance
The Auto Enhance function on the Edit Picture screen automatically analyzes and applies a color and 
saturation correction to the picture.    Select Auto Enhance to improve your image. 

Prior to saving you can
· Click Undo to cancel the last edit action you performed.
· Click Undo All to cancel all edit actions.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· The Undo function will not undo any changes that have been saved.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Fit to Window
The Fit to Window function on the Edit Picture screen scales the picture to fit within the viewing area 
of the window, resetting a zoomed image back to its original display.

1 Select Fit to Window to view your picture within the size of the view area.
2 Click Close to exit the Edit Picture screen.

Note
The Fit to Window function will not permanently affect your image.



Flip Horizontally and Flip Vertically
The Flip Horizontally and Flip Vertically function on the Edit Picture screen mirrors your picture on 
the horizontal or vertical plane. The buttons are located to the side of the rotate arrows.

· Select the Flip Vertical button to flip the image from top to bottom.
· Select the Flip Horizontal button to reverse the image from left to right.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· There is no Undo option available with this command as selecting it again undoes it.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Convert to Grayscale
The Convert to Grayscale function on the Edit Picture screen removes the colors from your picture 
and replaces them with shades of gray to create the look of a black-and-white photograph. To remove 
the colors, select Convert to Grayscale.

Prior to saving you can
· Click Undo to cancel the last edit action you performed.
· Click Undo All to cancel all edit actions.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· The Undo function will not undo any changes that have been saved.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Red Eye Reduction
Select Red Eye Reduction on the Edit Picture screen to correct the red eye color, seen in flash images,
to the natural color of the eye. Click the Red Eye Reduction button and the red glow from people’s 
eyes will be automatically removed.

Prior to saving you can
· Click Undo to cancel the last edit action you performed.
· Click Undo All to cancel all edit actions.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· The Undo function will not undo any changes that have been saved.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Rotate
The Rotate function on the Edit Picture screen revolves the image around its center point. 

· On the top right hand side of the Edit Picture screen, click the left arrow to rotate the image 
90º counter-clockwise.

· Select the down arrow to rotate the image 180º clockwise.
· Select the right arrow to rotate the image 90º clockwise.

Prior to saving you can
· Click Undo to cancel the last edit action you performed.
· Click Undo All to cancel all edit actions.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· The Undo function will not undo any changes that have been saved.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Convert to Sepia
The Convert to Sepia function on the Edit Picture screen changes the hue of your image and creates 
an aged look.    To give your picture an old time appearance, click Convert to Sepia. 

Prior to saving you can
· Click Undo to cancel the last edit action you performed.
· Click Undo All to cancel all edit actions.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· The Undo function will not undo any changes that have been saved.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Zoom
The Zoom function on the Edit Picture screen increases or decreases the magnification of your 
picture.

1 Click Zoom to access a drop down list of percentage zoom settings.
2 Select from the following options: 200%, 150%, 100%, 75%, 50%, 33%, 25%, and Other.

· If you select Other, you will open a zoom dialog box.
3 In the dialog box, input a number from 1 to 999.
4 Click OK.

Prior to saving you can
· Click Undo to cancel the last edit action you performed.
· Click Undo All to cancel all edit actions.

After you complete modifying the picture
· Click Save to overwrite your image.
· Select Save as a Copy to save the modified version into a new file. Your original image will

not be changed.
· Click Close to exit the Edit Picture screen. 

Notes
· If your picture is larger than the viewer window, use the scroll bars to view the image.
· The Undo function will not undo any changes that have been saved.
· To see the function of an image-editing tool before you use it, hold your mouse over the tool

for a few seconds.



Sorting Picture Folders
To sort your picture folders

1 On the File menu, choose Open My Picture Finder. 
2 Next to Sort By, choose how you want to sort your picture folders (by date or by name).





About the Web Browser
The Web browser is a built-in feature of the AOL software that allows you to access and view 
information located on the World Wide Web (WWW).
When you use America Online or want to access the World Wide Web, the Web browser is the tool that 
displays Web pages and helps you to navigate from one site to another.
AOL’s Web browser controls are located on the Navigation bar — the area right below the colorful 
toolbar icons.

For more information, see:
Clearing Your Browser Cache 
Determining Your Browser Version 
Going to a Web Site 
Internet Explorer Settings 
Opening HTML Files on Your Computer 
Printing a Web Page 
Selecting Another Browser as Your Default Browser 
Setting AOL as Your Preferred Browser 
Using Print Preview 
Using Print Setup 



Clearing Your Browser Cache
AOL's built-in browser temporarily stores images and text from World Wide Web pages on your hard 
drive in a storage area called a cache. When the cache fills up, performance can slow down, and your 
hard drive may run out of space.
To clear the browser cache (Microsoft Internet Explorer 5.5 and higher)

1 From the AOL Toolbar, click Settings.
2 In the AOL Settings window, click Internet Properties. The AOL Browser Settings window 

opens.

To erase all information about websites you’ve visited 
This is where you can erase your internet history and the list of keywords and Web addresses that you 
typed.

1 From the AOL Browser Settings window, Clear All Footprints tab, click Clear All Footprints.
2 The Clear All Footprints window opens. Click 

· Yes to erase all information
· Select Footprints to Clear to specify which settings you want to erase, or
· No to return to the AOL Browser Settings window.

To choose which items to erase
1 From the AOL Browser Settings window, Clear All Footprints tab, click Select Footprints to 

Clear. The Select Footprints to Clear window opens. 
2 Check the area(s) that you want to erase, and click Clear.
3 Click Close to close the window and return to AOL Browser Settings

Note
Clicking Clear All in the Select Footprints to Clear window will erase information about web 
pages you’ve visited from all areas.

For more information, see:
About the Web Browser 



Determining Your Browser Version
1 Sign on to the AOL service.
2 Go to AOL Keyword: Browser.

Note
If you are not using the latest version, you can also download it from AOL Keyword: Browser.

For more information, see:
About The Web Browser 



Going to a Web Site
1 Sign on to the America Online service.
2 Type the URL directly into the text entry box on the toolbar and press Enter.

For more information, see:
About the Web browser 



Opening HTML Files on Your Computer
HTML, or HyperText Mark-up Language, allows Web page designers to use nice fonts and text 
formatting on the World Wide Web (WWW). AOL's Web browser is actually the Microsoft Internet 
Explorer (MSIE) built seamlessly into the AOL software, so you can read HTML files and display 
them with formatted text and images. You can also see the HTML formatting codes embedded in the 
text.
To open an HTML file

1 On the File menu, click Open.
2 Navigate to the folder in which you saved the file.
3 Double-click the file to open it.

To view HTML code
1 Open the HTML file.
2 Right-click in the page window and click View Source on the shortcut menu that appears.

Note
AOL will only recognize HTML files with the .htm extension. It will open HTML files with 
the .html extension as a text file (all HTML tags will be visible).

For more information, see:
About the Web Browser 



Setting AOL as Your Preferred Browser
1 Sign on to the AOL service.
2 Click the Settings icon on the AOL toolbar.
3 In the Settings window, click the A-Z tab.
4 Click AOL as Default.
5 Click OK to select America Online as your preferred application for Web browsing, e-mail, and 

Newsgroups.

The e-mail and newsreader associations can be reset in the Internet Options Control Panel.
1 Click Start, point to Settings, and then click Control Panel (Windows XP users, click Start, 

and then click Control Panel).
2 Double-click Internet Options, and then click the Programs tab.
3 Choose the programs you wish to use for e-mail and newsgroups.

For more information, see:
About the Web Browser 
Selecting Another Browser as Your Default Browser 



Selecting Another Browser as Your Default Browser
1 Start the browser you want to be the default browser for other Windows programs. A dialog box 

will appear, asking if you want that browser to be the default browser.
2 Click Yes.

Notes
· Setting a default browser for other Windows programs does not affect the browser that AOL 

uses.
· If the dialog box asking if you want to make that browser the default does not appear, check 

your help file for the browser, or the manufacturer’s Web site for further information.

For more information, see:
About the Web Browser 



What's an URL?
The URL, or Uniform Resource Locator, is a path for locating sites on the World Wide Web. For 
example, http://www.aol.com is the URL for the America Online Homepage. 



Printing a Web Page
In addition to printing a page, you can use the Print Setup and Print Preview features to change your 
printing options and to view a page before you print it.

To print a page
1 While viewing the page you want to print, on the File menu, click Print.
2 Select the printer, page range, and number of copies.
3 Click Print.

For more information, see:
Using Print Setup 
Using Print Preview 



About Firewalls
A firewall is a program that acts as a gatekeeper between your computer and the Internet to help deter 
hackers and identity thieves from accessing private information stored on your computer. 
Firewalls can consist of hardware, software, or a combination of both. Since there are many firewall 
programs available, and since each one works differently, make sure you follow the manufacturer’s 
instructions for setting up and using the firewall. 
The AOL service offers McAfee Personal Firewall Express so you can help protect your personal 
information. McAfee Personal Firewall Express comes pre-configured to help optimize your AOL 
experience.

To get your free copy of McAfee Personal Firewall Express
1 Sign on to the AOL service.
2 Go to AOL Keyword: Firewall.
3 Under Protect Personal Information, click the Firewall link.

For more information, see:
Using AOL With a Firewall 





About AOL Calendar
AOL Calendar enables you to stay on top of important dates, help simplify event planning, and keep 
current with the latest plans of your family and friends. When you use AOL Calendar you can receive 
reminders anywhere on the Internet and through your cell phone, and get your daily horoscope and 
updated weather.
To use Calendar

1 Click the Services menu.
2 Select Calendar.

For additional information about how to use AOL Calendar, click the Help button in the top right 
corner of the Calendar window.

Note
Use of AOL Mobile services requires a text-messaging or wireless-enabled device and service 
plan. Additional charges from your wireless service provider may apply.



About Intellisync® for AOL
Intellisync® for AOL automatically synchronizes your AOL Calendar (including Reminders) with a 
variety of popular handheld devices and Windows applications. You can maintain the same list of 
appointments and events in both places, and use Intellisync for AOL to keep your data up-to-date and 
"in sync." 

Intellisync for AOL works with Palm OS® and Pocket PC handheld devices, as well as Microsoft® 
Outlook®,    Microsoft® Outlook® Express, and Palm™ Desktop Windows applications. 

Intellisync for AOL also works with your AOL Address Book, allowing you to keep a single contact 
list for all of your communications.  With Intellisync for AOL you will never be without an e-mail 
address or phone number again.

For more information about Sync, or to download Intellisync for AOL now, go to AOL Keyword: 
Sync.  Once you have installed Intellisync for AOL all you need to do is open your Address Book, 
choose Address Book Options, and then choose Sync to synchronize information between your 
Address Book and other devices and programs.



About the Log Manager
The Log Manager feature enables you to transfer online text to a file you can read or print offline. You 
can transfer text from:

· News or reference articles
· Message board posts
· AOL® Instant Messenger™ Service conversations
· Chat rooms and auditoriums

For more information, see:
Saving Conversations From Chat Rooms And Auditoriums 
Reading News Articles And Other Text Items When You Are Not Signed On 



Reading News Articles and Other Text Items When You are not 
Signed On

1 Sign on to the AOL service.
2 On the File menu, click Log Manager.
3 In the Session Log section, click Open Log.
4 Choose the location on your computer where you want to save the log file, and click OK.
5 Open the news articles or text items you want to read while offline.
6 When you are ready to stop logging, click Log Manager on the File menu.
7 In the Session Log section, click Close Log.
8 Sign off the AOL service.
9 To read the log file, click Open on the File menu.
10 Navigate to the folder where the log file you created is stored.
11 Double-click the log file to open it.

Note
If the log file you created is too large to be opened by the AOL program, use a word processing 
program to open the file.

For more information, see:
About the Log Manager 
Saving Conversations from Chat Rooms and Auditoriums 



Saving Conversations from Chat Rooms and Auditoriums
1 Sign on to the AOL service and enter the chat room or auditorium that you want to log.
2 On the File menu, click Log Manager.
3 In the Chat Log section, click Open Log.
4 Choose the location on your computer where you want to save the log file, and click Save.
5 Participate in the chat, or do other things (you must keep the chat room window open).
6 When you are ready to stop logging, click Log Manager on the File menu.
7 In the Chat Log section, click Close Log.
8 To read the log file, click Open on the File menu.
9 Navigate to the folder where the log file you created is stored.
10 Double-click the log file to open it.

Notes
· If the log file you created is too large to be opened by the AOL program, use a word 

processing program to open the file.
· You can only log open chat rooms. If you move to a new chat room, the log file will record 

the conversation in the new chat room.

For more information, see:
About The Log Manager 
Reading News Articles And Other Items When You Are Not Signed On 





About Downloading
Downloading is the process of transferring a file from one computer to another. Files you can 
download from AOL include pictures, sounds, text documents, videos, and programs. If your e-mail 
messages have attached files, you can download those as well.
WARNING! Never download e-mail attachments unless you know the sender! Downloaded files can 
contain computer viruses or Trojan Horse programs. The AOL service scans your e-mail attachments 
for viruses and repairs them whenever possible. However, you should always use caution when 
opening files, even from friends. Viruses and Trojan Horse programs may cause harm to your computer
hardware or software, can contain objectionable graphics, or may even compromise the security of 
your AOL account. When downloading files, you should always check for viruses and Trojan Horse 
programs before you open the files. To learn more about computer viruses sign on to the America 
Online service and go to AOL Keyword: AntiVirus. 



File Types and Extensions
Files available online include text files, programs, images, sounds and videos. The file name may 
indicate what type of file it is. The file name extension—the letters after the period at the end of the file
name—help you determine what kind of application can open the file. (If the extension is .exe, the file 
is itself an application.)
Extensions are used more often for Windows files, but you will also see certain extensions used for 
Macintosh files. Not all file names have extensions, and not all extensions indicate the file type.
Below is a list of common file extensions and information on the type of file (graphics, programs, 
sounds) they indicate:
.arc Indicates a file compressed using the program ARC (archive).
.art Indicates a graphics file compressed using the AOL service's Johnson-Grace system. These files 
can be viewed using your AOL software but can't be opened with most other programs.
.asf, .asx Indicates a Windows Media Player sound file. The AOL service's Windows software can
play these files. Other Windows Media Player files include .wm, .wma, and .wmv.
.avi Indicates an audio visual file, used for Windows video files. The AOL service's Windows 
software will display these files.
.bmp Indicates a Windows bitmap--a type of graphics file. The AOL service's software can display 
these files.
.dll Indicates a Dynamic Link Library. These files allow different programs to work together. They 
usually need to be installed into the Windows/System directory.
.eps Indicates an Encapsulated Postscript File. These are images designed for vector, or line-based, 
drawing programs such as Adobe Illustrator. The AOL service's software cannot display these files.
.exe Indicates an executable file that is, a program; these files are usually DOS or Windows 
applications. Be careful when downloading any .exe files from someone you don't know. They may 
contain viruses or Trojan Horse programs. Protect yourself and find more information at Keyword: 
AntiVirus
.gif Indicates Graphics Interchange Format--a type of graphic image very common in online 
services and the Internet. GIF includes file compression as part of its definition, so no additional file 
compression software is needed. The AOL service's software can display these files.
.jpg or .jpeg Indicates Joint Photographers Expert Group--a graphics format designed to take up as 
little space as possible while retaining as much quality as possible. JPG files are smaller than GIF files,
but take longer to display. The AOL service's software will display these files.
.me This file extension tells you to do something. For example, files named read.me usually contain 
last-minute instructions and updated information.
.mid (.midi) Indicates a Musical Instrument Digital Interface file. MIDI files are songs for most 
sound cards and MIDI boards. The AOL service's software will play these files.
.mme Indicates a Multipurpose Internet Mail Extensions (MIME) file. MIME converts a binary 
attachment (a program or word processing document or even an image) to a text format that can be 
handled by the machines that send e-mail through the Internet.
.mod Indicates a music module. These are music files that include the instruments as well as the score,
and they play through a sound card, not MIDI. You will need a special program to play these files in 
Windows or on a Macintosh computer.
.mpeg, .mpg Indicates a widely-used video file format.
.mp2, .mp3 Indicates a music file format. These file formats store CD-quality sound in a 



compressed format, which allows you to quickly download and store hundreds of music files on your 
computer without using a large amount of disk space. 
.m3u, .pls Indicates a music playlist file. These file formats are a standard playlist format used by 
popular media programs, as well as the AOL service.
.pcx Indicates older graphics files, commonly used for clip art.
.pct or .pict Indicates the original Macintosh graphics format. The AOL service's Macintosh 
software will display these files.
.pdf Indicates Adobe® PDF (portable document format). PDF is a universal file format that 
preserves the fonts, graphics, and layout of a document so that it can be shared, viewed, searched, and 
printed by anyone who has the free Adobe Reader® software, available from Adobe.
.qt, .qtl, or .mov Indicates a QuickTime file (.qt), a QuickTime Application (.qtl) file, or a 
QuickTime movie (.mov) file. QuickTime is a multimedia file format for audio and video.
.ra, .ram, .rm, .rmj, or .rt Indicates a RealPlayer or RealOne Player audio file format for sound 
files.
.sea Indicates a self extracting archive--a type of compression file. These are Macintosh files that, 
when run, 'unfold' into several smaller files. They cannot be used in Windows.
.scr Indicates a Windows screen saver file. These will not work unless placed in your C:\Windows 
directory.
.sit Indicates a StuffIt file. These are Macintosh compressed files that can be extracted by Windows 
users with programs such as UnSit and UnStuff. Some of the files with this extension will not run on 
Windows, even after extraction. The AOL service's Macintosh software will open these files.
.smi, .smil Indicates a RealPlayer graphics file format that allows graphics to be streamed over the 
Internet.
.tif Indicates a Tagged Image Format--bitmapped graphic images popular among desktop 
publishers. The AOL service's software will not display these files.
.ttf Indicates a True Type Font. These are scalable fonts commonly used in Windows. You will need 
to run the Windows Control Panel to install them.
.txt Indicates a text file. These are usually just plain text that can be read by most programs, 
especially Notepad, on Windows, and Simple Text, on Macs. The AOL service's software will display 
these if they are 32K or less in size.
.wm, .wma., or .wmv Indicates a Windows Media Player sound file. The AOL service's Windows 
software can play these files. Other Windows Media Player files include .asf and .asx.
.wav Indicates a Windows sound file. Mac users can find utilities in the Software Center at Keyword: 
Software to convert them to sound files that the Macintosh can play. The AOL service's Windows 
software will play these files.
.zip Indicates a PKzip archive. This is the most common format for compressed Windows files. 
AOL's Windows software can automatically decompress these files.

For more information, see:
About Downloading 



Downloading Files from the Download Center
The Download Center is an AOL service module that provides you with a wide range of files for 
downloading--everything from games to sounds. 

1 Sign on to the AOL service.
2 Open the Download Center by typing the keyword File Search or by choosing Download 

Center from the Services Menu.
3 Locate the file you’d like to download.
4 Click the Download button.

While you’re using the Download Center, extensive onscreen help is available to assist you in 
downloading files, uploading your own files for others to use, and in other matters such as paying for 
commercial software.
WARNING ! Downloaded files can contain computer viruses or Trojan Horse programs. Viruses and 
Trojan Horse programs may cause harm to your computer hardware or software, can contain 
objectionable graphics, or may even compromise the security of your AOL account. When 
downloading files, you should always check for viruses and Trojan Horse programs before you open 
the files. To learn more about computer viruses and your anti-virus software, sign on to the AOL 
service and visit AOL Keyword:    AntiVirus.

For more information, see:
About Downloading 
About File Types And Extensions 
Locating Files You've Downloaded 



Downloading Files from the Internet
There are a number of sites on the Internet that offer files for downloading. In addition, many software 
manufacturers distribute software and/or software updates by downloading. 

1 Sign on to the AOL service.
2 Navigate to the appropriate Internet location.
3 Locate the file you would like to download.
4 Follow the onscreen instructions to download the file to your computer.

While downloading is a simple process, each site will require slightly different procedures and many 
sites will ask you for personal and/or payment information.
WARNING ! Downloaded files can contain computer viruses or Trojan Horse programs. Viruses and 
Trojan Horse programs may cause harm to your computer hardware or software, can contain 
objectionable graphics, or may even compromise the security of your AOL account. When 
downloading files, you should always check for viruses and Trojan Horse programs before you open 
the files. To learn more about computer viruses and your anti-virus software, sign on and go to AOL 
Keyword: AntiVirus.

Note
Many downloaded files have been compressed so they will take up less space on your hard drive
and transfer in less time. The AOL service automatically decompresses most common 
compression formats when you sign off. Some compression formats may require special 
software to decompress.

For more information, see:
About Downloading 
About File Types And Extensions 
Locating Files You've Downloaded 



Downloading Files Attached to E-Mail
When you receive mail with a small diskette and envelope icon  in your New Mail window, that 
means there's a file attached to the message. In order to see or use the attached file, you need to 
download it. Remember: NEVER download a file unless you know the person who sent it.

To download files attached to e-mail you receive:
1 Sign on to the America Online service.
2 Click the Read icon on the AOL toolbar.
3 Double-click the piece of e-mail with the file attachment to open it.
4 Click Download, then click Download Now.
5 In the Download Manager window, click Save. A confirmation window will appear asking if 

you would like to locate the file now.
· Click Open File if you would like to view the file immediately (this works only if you have 

software capable of opening the type of file you just downloaded)
· Click Find File to have the AOL service open the folder that the file was saved to.
· Click Close if you wish to open the file at a later time.

You can also use the Download Manager to download e-mail attachments. 

Notes
· To help you safeguard your computer from potential viruses and Trojan Horse programs, 

Open File is not available on the download confirmation window for file types that may 
contain harmful code (e.g., EXE, VBS, BAT, COM, etc.).

· To mark files to be downloaded later, click Download on the mail window, then click 
Download Later.

· All files you download are placed in the My Documents folder on your computer, unless 
you have changed the default download destination folder. If a different location was used in
a previous download, all subsequent downloads will use that download location until the 
AOL software is restarted.

· If you receive a suspicious file from someone you do not know, click Forward and send the
e-mail to screen name TOSReports.

· You must have software that is compatible with the file(s). For example, if you receive a 
WordPerfect file, you must have either WordPerfect or a word processing program capable 
of opening WordPerfect files. Also make sure the file is compatible with your computer; a 
Macintosh machine may not be able to read some Windows files, and vice versa.

For more information, see:
About Downloading 
Locating Files You've Downloaded 
Setting Download Preferences 
About The Download Manager  



Locating Files You've Downloaded
When you download files from the Download Center, you choose where they’re downloaded. You can 
usually do the same with files downloaded from the Internet. If you forget where the files are, you can 
find them using the Search feature from the Start menu. The following procedure is for the Download 
Manager only.

1 On the File menu above the AOL toolbar, click Download Manager.
2 Select the file you want to locate on your computer.
3 Click Find File to access the file.

For more information, see:
About Downloading 
Downloading Files 
Downloading Files Attached To E-Mail 



Problems with Compressed (Zipped) Files
You may experience problems compressing or decompressing files for these reasons:

The compressed file is damaged
Contact the person who sent you the file.

Lack of space on your computer 
Your computer may not have enough hard drive space to hold both the compressed file and the 
decompressed file into its original larger file. Delete some files on your computer that you no longer 
need. 

For more information, see:
About Downloading 
About Zipped (Compressed) Files 



About Compressed (ZIP) files
Files are zipped, or compressed, for two basic reasons: to fit a number of files into one space or to 
reduce one very large file to a smaller size. Compressed files download faster and save storage space, 
but they must be decompressed before you can use them.
Most compressed Windows files end with a .zip file extension and most compressed Mac files end in 
a .sit file extension, and these compression formats are often not cross-platform compatible. For 
example, the AOL service’s Windows software cannot generally decompress Macintosh .sit files.
In most cases, you will not need additional software to compress or decompress your files.
If you attach more than one file to e-mail you send to another AOL member, the AOL software 
automatically compresses your files together into one .zip file for the recipient.
If you attach more than one file to e-mail you send to an Internet recipient, the files remain as separate 
attachments and are not zipped.
You can set a preference to have the AOL service automatically decompress/expand ZIP files upon 
download.
To find and download third-party software for other compressing or decompressing needs, sign on to 
AOL and go to AOL Keyword: Download Center and search on the word "zip." You'll find instructions 
for using these programs in the documentation that accompanies them.



About the Download Manager
The Download Manager allows you to download e-mail attachments at the end of your AOL session, 
or, using Auto AOL, at any later time you specify. If you can’t locate files you’ve already downloaded, 
you can use the Download Manager to find them. When you find an attachment you want to save to 
your hard drive at a later date, click Download Later to store the file in your Download Manager.        
You can perform various tasks in the Download Manager:
View Details lets you read descriptions of the stored attachments (this option is only available when 
you are signed on.)
Finish Download initiates the download process (this option is only available when you are signed 
on.)
Find File lets you find the files that you previously downloaded to your computer.
Remove Item lets you delete a file from the list.
Preferences lets you edit your download settings.

Warning!
Files sent over the Internet or through e-mail can contain computer viruses or Trojan Horse programs. 
The AOL service scans your e-mail attachments for viruses and repairs them whenever possible. 
However, you should always use caution when opening files, even from friends. Viruses and Trojan 
Horse programs can cause harm to your computer files, may contain objectionable graphics, or can 
even compromise the security of your AOL account. When downloading files, you should always 
check for viruses and Trojan Horse programs before you open the files. To learn more about computer 
viruses and your anti-virus software, sign on and go to AOL Keyword: AntiVirus. 



Downloading Files Already Stored in the Download Manager
1 Sign on to the America Online service.
2 On the File menu above the AOL toolbar, click Download Manager.
3 From the list of files selected to be downloaded later, choose the file or files you want to 

download. Click each file to select it.
4 Click Finish Download.

For more information, see:
Marking Files To Be Downloaded 



Marking Files to be Downloaded
1 Sign on to the America Online service.
2 Locate the e-mail attachment you want to download.
3 Click Download, then click Download Later.
4 On the File menu on the AOL toolbar, click Download Manager. The file you chose to 

download later will be listed.

For more information, see:
About The Download Manager 
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